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Preface

e Conventions on page 32
e Text Conventions on page 32

e |Message Icons on page 32

Conventions

Text Conventions

Convention Use
Bold Highlights items you can select in the SonicOS management interface.
Menu Item > Menu Item Indicates a multiple step Management Interface menu choice. For example,

Security Services > Content Filter means select Security Services, then
select Content Filter.

Screen Text Indicates text as you would see it on a computer screen or would enter in a
field or on a command line. For example, myDevice > show alerts

Message Icons

These special messages refer to noteworthy information, and include a symbol for quick identification:

A

WARNING: Important information that warns about a potential for property damage, personal injury,
or death

/\| CAUTION: Important information that cautions about features affecting firewall performance, security
features, or causing potential problems with your SonicWall appliance.

@ | TIP: Useful information about security features and configurations on your SonicWall appliance.
@ | IMPORTANT: Important information on a feature that requires call out for special attention.
@l NOTE: Supporting information on a feature.

@l MOBILE: Useful information about mobile apps for your SonicWall appliance.

® | VIDEO: Links to videos containing further information about a feature on your SonicWall appliance.
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About SonicOS

The web-based SonicOS management interface allows you to configure and administer SonicWall network
security appliances (firewalls) running SonicQOS 6.2:

SuperMassive 9800 NSA 6600 TZ600 SOHO Wireless
SuperMassive 9600 NSA 5600 TZ500/TZ500 Wireless
SuperMassive 9400 NSA 4600 TZ400/TZ400 Wireless
SuperMassive 9200 NSA 3600 TZ300/TZ300 Wireless
NSA 2600

e Management Interface on page 33
e Dynamic User Interface on page 34
e Navigating the Management Interface on page 34
e [cons and Buttons in the Management Interface on page 35
e Status bar on page 39
e Applying Changes on page 39
e Tooltips on page 40
e Navigating Dynamic Tables on page 42
e Management Interface Options on page 43
e Command Line Interface (CLI) on page 44

e Registering Your SonicWall Security Appliance on page 44

Management Interface

SonicOS provides an easy-to-use, graphical interface for configuring your network security appliance. The
following sections provide an overview of the key management interface features:

e Dynamic User Interface on page 34

e Navigating the Management Interface on page 34

e |cons and Buttons in the Management Interface on page 35
e Status bar on page 39

e Applying Changes on page 39

e Tooltips on page 40

e Navigating Dynamic Tables on page 42

e Management Interface Options on page 43

SonicWall SonicOS 6.2 Administration Guide

About SonicOS 33



Dynamic User Interface

Table statistics and log entries are dynamically updated within the user interface without requiring users to
reload their browsers. Active connections, user sessions, VolIP calls, and similar activities can be disconnected or
flushed dynamically with a single click on the Delete icon in the Flush or Logout column.

This dynamic interface is designed to have no impact on the Web server, CPU utilization, bandwidth or other
performance factors. You can leave your browser window on a dynamically updating page indefinitely with no
impact to the performance of your firewall.

Navigating the Management Interface

Navigating the management interface is facilitated by a hierarchy of menu items on the navigation bar (left side
of your browser window). When you click a menu item, related management functions are displayed as
submenu items in the navigation bar.

= Dashboard

Real-Time Manitor El]
AppFlow Dash @
AppFlow Monitor

AppFlow Reports
Threat Reports

[E1]

User Monitor
BWM Monitar
Connection Monitor

Packet Maonitor

EEEEE

Log Monitor
4 E‘ System
» g Metwork
3 x Switching
» @ 3G/4GModem
4 é SonicPaint
» % Firewall
» % Firewall Settings
4 @ DPI-S5L
» DPI-S5H

Capture ATP

»

-

VoIP

L4

VPN

L4

SEL VPN

Virtual Assist

L4

il o *F- XL 9)

v
f

Users

High Availability

» G Security Services
b A WAN Acceleration

» @ AppFlow
L4 @ Log @
If the navigation bar continues below the bottom of your browser, up-and-down arrow buttons appear in the

bottom right corner of the navigation bar. Mouse over the up or down arrow to scroll the navigation bar up or
down. You also can use the scroll wheel on your mouse.
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Icons and Buttons in the Management Interface

Topics:
e Common Icons on page 35
e Display Icons on page 37

e Common Buttons on page 38

Common lcons

The Management Interface uses icons to facilitate certain actions. Some icons are common throughout the
Management Interface while others apply to only one or two pages. Common icons describes the functions of
common icons used in the Management Interface:

Common icons

Action Icon Description
Edit 7 Displays a dialog (secondary or popup window) for editing the
settings.
Delete (3% Deletes a table entry.
Comment (=) Displays text from a field entry or information about the table entry.
Funnel ? Indicates access rules with bandwidth management.
Upload E Uploads a file to a common database or external switch.
Print = Exports the data flow to a printer or file.
L=
Print PDF Report For some Ul pages, prints a pdf file.
Send Report = Downloads a visualization report.
Email = Sends the log to an email address.
Refresh ~ Updates the real-time data in a table, chart, or other display.
L=}
Notes — Displays a popup balloon containing status or statistics about an
= entry in tables.
Statistics i ;I": Displays a popup balloon containing statistics about an entry in
w tables or general status about the table or page.
Clear Statistics == Updates the statistics shown in the traffic tables.
TR
Configure ® Allows for customization of the display. The function changes with
- the page containing the icon.
NOTE: The Configure icon and Configure button have different
functions.
Left-arrow o Displays a pop-up balloon containing the respective VPN policy in
the middle of the page.
Priority il Displays a pop-up containing statistics about an entry in tables or

general status about the table or page.

SonicWall SonicOS 6.2 Administration Guide

About SonicOS 35



Common icons

Action Icon Description
Enabled 2 Indicates the interface or service is enabled. Clicking on the icon
disables the interface or service.
Indicates the option or event is enabled. Clicking on the icon
disables the option or event.
i or Indicates a service, such as Guest Services, is enabled for the
user/group. Mousing over the icon displays a popup message.
$ord Solid indicates that all members of the category, group, or event are
enabled.
woriy Semi-solid indicates that some are enabled, some are disabled.
Disabled (%] Indicates the interface or service is disabled. Clicking on the icon
enables the interface or service.
Indicates the option or event is disabled. Clicking on the icon
enables the option or event.
Qor Indicates that all members of the category, group, or event are
disabled.
Link E Provides a link to another page in the UL. Clicking the link displays
the page.
Import .\i’/—. Imports certificate information or images.
Reboots the firewall with the firmware version listed in the same
row
Export 2 Exports a VPN policy to a file in either encrypted or non-encrypted
format.
X Exports the data flow into a comma separated variable (.csv) file.
The default file name is sonicflow.csv.
[ Exports the log as a CSV-format file. Clicking this icon displays a
o dialog that allows you to open or save the log in CSV format.
(bt Exports the log as a plain text-format (. txt) file.
Boot @ Imports certificate information or images.
Reboots the firewall with the firmware version listed in the same
row.
Information @ or @ or O D.isplays popup dialogs containing more detailed information than
displayed on the page.
Question Mark 7
Help
Tooltip Toriz Displays information about an option or setting on a page, report, or
dialog; see Tooltips on page 40.
Search e Searches a table for the specified data.
NOTE: The Search icon and the Search button are used on different
pages.
Status “,, Status | Indicates the status of the feature:
o e Green signifies that the feature is active and operating.
! | Status e Yellow signifies the feature is not active or operating.
. e Red signifies the feature is disabled.
! Status
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Common icons

Action Icon Description

Collapse E or IE‘ or v Hides a chart, table, or section of a management interface page to
allow more display room for other data.

Expand or |E| or ¥ Redisplays a hidden chart, table, or section of a management
interface page.

Display @ or @ Opens a new tab in your browser that displays only the report or
graph associated with a submenu item. For more information, see
Display Icons on page 37.

Pause @ Freezes the data flow. The time and date also freeze.
The Pause icon appears gray if the data flow has been frozen.
NOTE: On some pages, Pause and Play are the same icon that
toggles between functions. That is, when clicked, the Pause icon
becomes the Play icon, and when clicked, the Play icon becomes the
Pause icon.

Play rp Unfreezes the data flow. The time and date refresh as soon as the

L data flow is updated.

The Play icon appears gray if the data flow is live.
NOTE: On some pages, Pause and Play are the same icon that
toggles between functions. That is, when clicked, the Pause icon
becomes the Play icon, and when clicked, the Play icon becomes the
Pause icon.

Stop Ill Stops services for an appliance.

Start Ll Resumes stopped services for an appliance.

Reject = Disables a built-in common name, but does not delete it.

Accept * Enables a built-in common name.

Add Displays a dialog (secondary or popup window) for adding entries to
a table.

Remove Removes a local user from a group.

Clock Displays a popup balloon containing information about account and

session expirations.

Displays a popup balloon containing information about schedules.

Chart Format:
Bar Chart
Flow (Area) Chart

Toggles the display of a chart between bar and flow (area) formats.

NetExtender

Launches and configures NetExtender.

Display Icons

Most submenus in the Dashboard menu have a Display [#] icon associated with them. Clicking on the icon for a
submenu item opens a new tab in your browser that displays only the report or graph associated with that
submenu item. You can display all these submenu items or only the ones of interest. When the submenu item is
in a new tab, you can move the tab to a new browser window to display separately from the management

interface.
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Other submenus that display sometimes rapidly changing data also have a Display @ icon associated with them.
This icon is located at the top of the submenu page near the Mode option. This Display icon works the same as
those of the Dashboard submenus and is also associated with them.

Common Buttons

The Management Interface uses buttons to facilitate certain actions. Some buttons are common throughout the
Management Interface while others apply to only one or two pages. Common buttons describes the functions
of common buttons used in the management interface:

Common buttons

Action Button Description

Accept Applies the changes entered on certain Interface Management
pages.

OK oK Applies the changes entered on the Interface Management page or
for a dialog, applies the changes and closes the dialog.

Save Applies the changes made in a dialog and then closes the dialog.

Apply Apply Applies the changes made in a dialog, but does not close the dialog.

Cancel Cancel Discards the changes entered on the Interface Management page or
for a dialog, discards any changes made in the dialog and closes the
dialog.

Close Discards any changes made in the dialog and closes the dialog.

Help Help Displays the help page for the dialog.

Add Add. Displays a dialog that allows you to add elements, such as zones,
services, and access/firewall rules, to your appliance.

Configure Corfigure... Displays a configuration dialog for configuring SonicOS settings.
NOTE: The Configure button and Configure icon have different
functions.

Default Default Erases current values and restores factory default values.

Create Rule Create Rule Displays the dialog for creating AppFlow rules.

Refresh Refresh Updates real-time data in a table.

Update Update Updates entries in a table.

Delete Delete Deletes the selected items from a table.

Delete Box = Deletes the item, especially in a filter.

Delete All Delete Al Deletes all items except default and system-generated items in a
table.

Remove Remove Deletes the selected items from a table.

Remove All Remove Al Deletes all items in a table.

Flush Flush Removes one or more selected items in a table.

Flush All Flush Al Removes all items in a table.
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Common buttons

Action Button Description

Purge — Deletes one or more selected FQDN objects from a table.

Purge All Purge Al Deletes all FQDN objects from a table.

Clear Clear Clears the packet monitor queue and the displayed statistics for the
capture buffer, mirroring, and FTP logging.

Clear Statistics Clear Statistics Clears the counters and the displayed statistics; restarts the
counters.

Filter View Filter View Correlates data among tabs in the AppFlow Monitor page.

e Ly Adds or deletes a filter based on selected criteria.

Filter Add = Adds the selected element to the filter

Install =5 Installs a SonicWall SSO Agent feature.

Preview Praview... Displays the HTML message in a dialog for verification of how the
message looks.

Example Example Template Reverts the HTML message code to the default HTML message.

Template

Go Go Performs the specified lookup.

Lookup Lookup Performs the specified lookup.

Right Arrow . Moves an item from a generic list to a specific list.

Left Arrow o Removes an item from a specific list to a generic list.

Double Right o Moves items from a generic list to a specific list.

Arrow

Double Left << Removes items from a specific list to a generic list.

Arrow

Status bar

The Status bar at the bottom of the management interface window displays the status of actions executed in
the management interface. If the action was not completed, the Status bar displays an error message.

Status: Ready

Applying Changes

Click the Accept button at the top of the management interface to save any configuration changes you made on

the page.

If the settings are contained in a dialog (secondary window) within the Management Interface, the settings are
applied automatically to the firewall when you click OK. To apply the settings without closing the dialog, some
dialogs have an Apply button.
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To cancel any configuration changes before applying them, click the Cancel button at the top of a management
interface page or the bottom of a dialog.

Tooltips

Topics:
e Generic Tooltips on page 40
e Tooltips with Values on page 40

e Configuring Tooltips on page 41

Generic Tooltips

SonicOS provides embedded tooltips, or small pop-up balloons, that display when you hover your mouse over
an element in the management interface or click on a small triangle after the element. They provide brief
information describing the element. Tooltips are displayed for many forms, buttons, table headings and entries.

Default Table Size: 50 items per page "

Auto-updated Table Refresh Interval: 10 inseconds 7

Enable Client Certificate Check Table Refresh Interval
Client Certificate [ssuer: ComS3ign CA Set the interval for background
auto-refresh of Monitor tables =
|:| Enable OCSP Checking (Process Monitor, Active Connections
R Monitor, Interface Traffic Statistics,
Default Table Size: 50 items per pag| etc,).

Auto-updated Table Refresh Interval: 10 in seconds 2=

NOTE: Not all Ul elements have Tooltips. If a Tooltip does not display after hovering your mouse over an
element for a couple of seconds, you can safely conclude that it does not have an associated Tooltip.

Tooltips with Values

When applicable, Tooltips display the minimum, maximum, and default values for form entries. These entries
are generated directly from the SonicOS firmware, so the values are correct for the specific platform and
firmware combination you are using.

Complexity Requirement

Upper Case Characters:

Administrator Timeout

Set the allowed period of inactivity before
administrators are automatically logged out of the
management interface.

Lower Case Characters:

MNumber Characters:

BEEN

Symbolic Characters: Min: 1
s ? e Max: 9999
traints for: i
Apply the above password constrain r Al Default: c istrators
Log out the administrator after inactivity of (minutes): &0 r gl

Several tables include a tooltip that displays the maximum number of entries that the appliance supports. For
example, the Firewall > Address Objects page displays the maximum number of address groups the appliance
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supports. These entries are generated directly from the SonicOS firmware, so the values are correct for the
specific platform and firmware combination you are using.

App Rules Policies

View Filter:  Policy Type: Al hd Action Type:  All

Filter By Logged In User: Add New Policy TSA user number; 0
Click to display the Add/Edit App

# Name Control Policy configuration screen. o= Bt f
50

Max Entries:
Mo Entries

Add MNew Policy Delete

App Rules Policies: 0 Policies Defined, 0 Policies Enabled, 50 Maximum Policies Allowed

Tables that display the maximum entry tooltip include NAT policies, access rules, address objects, and address
groups.

Configuring Tooltips

The behavior of the Tooltips can be configured in the Web Management Settings on the System >
Administration page.

Use System Dashboard View as starting page

Enable Tooltip
Form Tooltip Delay: 2000 in meecs
Button Tooltip Delay: 3000 in meecs
Text Tooltip Delay: 00 in msecs

Tooltips are enabled by default. To disable Tooltips, clear the Enable Tooltip checkbox. The duration of time
before Tooltips display can be configured:

e Form Tooltip Delay - Duration in milliseconds before Tooltips display for forms (boxes where you enter
text).

e Button Tooltip Delay - Duration in milliseconds before Tooltips display for radio buttons and checkboxes.

e Text Tooltip Delay - Duration in milliseconds before Tooltips display for Ul text.

Manipulating Tables

Topics:
e Navigating Dynamic Tables on page 42
e Sorting Tables on page 42
e Removing Table Entries on page 43

e Displaying Statistics on page 43
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Navigating Dynamic Tables

In the SonicOS dynamic user interface, table statistics and log entries dynamically update without requiring you
to reload your browsers.You can navigate tables in the management interface with a large number of entries by
using the navigation buttons located on the upper-right top corner of the table.The table navigation bar includes
buttons for moving through table pages:

Ttems per page § Items 1 to 5 (of 13) O fi(2]|3]| ®

A number of tables now include an option to specify the number of items displayed per page.

Sorting Tables

Tables are sorted automatically by the first column of data (not the # column). Many tables can be re-sorted by
clicking on the headings for the various columns. On tables that are sortable, the cursor becomes a pointing
hand when you mouse over the column headings. On some sortable tables, a Click to sort by tooltip appears
when you mouse over the column headings.

SonicPointh Provisioning Profiles

Add SonicPa| CICK t0 Sortby DR Profile Add SonicPoint ACe/AC/NZ Profile
Mame Prefix

Applied Zone Radic 0 Radio 0 Channel Radio 1
SSID: sonicwall-6 100 Band:  Auto SSID: sonicwall-61D0-1
[]1  SonicPointACe/ACINZ WLAMN
Mode: 5GHz nfafac Channel; Auto Mode; 2,4GHz nfg/b

When tables are sorted, entries with the same value for the column are grouped together with the common
value shaded as a sub-heading. In the following example, the Route Packets table is sorted by Priority.

Route Policies Items 1 to 12 {0f 12) (a[a [ [0
View Style: @ plpoices  © Custom Policies () Default Policies View IP Version: @ IPvdonly @ IPveOnly ) IPv4and IPv6
Destination Service ay Interface Priarity Probe  Comment Configure
01 MGMT IF Any Any MGMT Default Gateway MGMT 1 1 Q &
Oz Any MGMT IF Any 0.0.0.0 MGMT 1 2 Q “
[13  any 255,255,255, 25532 Any 0.0.0.0 X0 0 & =) 7
a4 Any %1 Default Gateway Any 0.0.0.0 X1 20 7 Q &
|:| 5 Any ¥0 Subnet Any 0.0.0.0 X0 20 9 Q &
|:| [ Any %1 5ubnet Any 0.0.0.0 X1 20 10 Q &
|:| 7 Any %2 Subnet Any 0.0.0.0 X2 20 11 Q &
|:| 2 Any ¥4 Subnet Any 0.0.0.0 x4 i) 12 Q &
e Any WTDO Subnet Any 0.0.0.0 WTO 20 13 =) Vi
110 any VPN _tuninel Subnet Any 0.0.0.0 WPN_tunnel 20 14 Q &
111 %P Any Any %1 Default Gateway ¥l 20 15 Q &
[112 Any 0.0.0.0/0 Any 10.203.28.1 %1 0 16 =4 7
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Removing Table Entries

Active connections, user sessions, VolP calls, and similar activities can be disconnected or flushed dynamically
with a single click on the Delete icon in the Flush or Logout column.

To flush one or more selected items in the table, click the Flush button. To flush all the items in the table, click
the Flush All button.

To delete one or more selected FQDN objects from a table, click the Purge button. To flush all the FQDN objects
from the table, click the Purge All button.

Displaying Statistics

[T ga WAN > WaN 3 ﬁ:er:ﬁce S IKE alow Al & ] () (&) (2
M 70 WAN > WAN 4 Any VAN KE alow | Access Rule #73 - Traffic @
Interface IP et
Statistics
VAN Primary Rx Bytes: 30555555
WAN > WAN 5 An IKE Allow @
=7 P # Ryt Packets: 29955
- Tx Byltes: 2557639
VAN Primary
™ 72 WAN > WaN 6 Any P IKE Alow | 14 Packets: 28350 z
Allx1 .
[T 73 wan = WAN 7 Any Management Management Allow Al - V] @ ‘

P

Several tables include a table Statistics icon that displays a brief, dynamically updating summary of information
for that table entry. Some tables with the Statistics icon are:

Port Configuration tab on the Network > PortShield Groups page
NAT Policies on the Network > NAT Policies page
Relay Protocols on the Network > IP Helper page
Access Rules on the Firewall > Access Rules page

App Rules Policies on the Firewall > App Rules page

To update the real-time data in a table, click the Refresh icon or the Refresh button.

To clear the statistics and start statistics collection anew, click the Clear Statistics button.

Management Interface Options

Wizards | Help | Logout

Mode: Mon-Config &

The top-right corner of every management interface page has the following options that you can click:

Wizards (Guides) on page 44
Help on page 44

Logout on page 44

Mode on page 44
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Wizards (Guides)

@ | NOTE: The terms wizards and guides are interchangeable.

Each firewall includes a Configuration Guide option that steps you through various firewall configurations, such
as Setup, PortShield interface, Public Server, VPN policies, LAN network, wireless LAN network, and 3G/4G
Modem. Clicking Wizards accesses the Configuration Guide dialog.

Help

Each firewall includes Web-based online help that explains how to use management interface pages and how to
configure the firewall. Clicking Help accesses the context-sensitive help for the page.

Some of the dialogs also have a Help button that accesses context-sensitive help for the window.

Logout

Each firewall includes a Logout option that terminates the management interface session and displays the
authentication page for logging into the firewall. Clicking Logout logs you out of the firewall.

Mode

Each appliance includes a Mode option that toggles the configuration mode of the management interface
between:

e Configuration mode — You can make changes to the settings of the firewall.

e Non-Config mode — You can only view the settings of the firewall and cannot make any changes or view
some management interface pages.

Clicking the arrow next to Mode: Configuration/Non- Config, allows you to toggle between configuration
mode and non-configuration mode.

Command Line Interface (CLI)

The SonicOS Enterprise Command Line Interface (E-CLI) provides a concise and powerful way to configure
SonicWall network security appliances without using the SonicOS web-based management interface. You can
use the CLI commands individually on the command line or in scripts for automating configuration tasks.

For a listing of Command Line Interface (CLI) commands for SonicOS 6.2 firmware, refer to the SonicOS 6.2 CLI
Reference Guide.

Registering Your SonicWall Security Appliance

After you have established your Internet connection, it is recommended you register your SonicWall Security
Appliance. Registering your SonicWall Security Appliance provides these benefits:

e Try a FREE 30-day trial of SonicWall Intrusion Prevention Service, SonicWall Gateway Anti-Virus, Content
Filtering Service, and Client Anti-Virus

e Activate SonicWall Anti-Spam

e Activate SonicWall security services and upgrades
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e Access SonicOS firmware updates
e Get SonicWall technical support

For instructions about creating a MySonicWall account as well as registering and licensing your SonicWall
appliance, see the Getting Started Guide for your appliance and Managing SonicWall Licenses on page 167.

®

NOTE: Make sure the Time Zone and DNS settings on your appliance are correct when you register the
device.

@l NOTE: mysonicwall . com registration information is not sold or shared with any other company.
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Dashboard

e Using the SonicOS Visualization Dashboard
e Monitoring Multi-Core Usage

e Monitoring Real-Time Traffic Statistics

e Viewing the Top-10 AppFlow Reports

e Monitoring Real-Time Network Data

e Configuring AppFlow Statistics and Viewing Reports
e Viewing Threat Reports

e Monitoring Active Users

e Monitoring Interface Bandwidth Traffic

e Monitoring Active Connections

¢ Monitoring Individual Data Packets

¢ Tracking Potential Security Threats
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Using the SonicOS Visualization
Dashboard

e Visualization Dashboard on page 47
e Dashboard Overview on page 47

e Enabling the Real-Time Monitor and AppFlow Collection on page 47

Visualization Dashboard

@ NOTE: App Visualization (Real-Time Monitor and AppFlow Monitor) is supported on TZ series and above
appliances.

Topics:
e Dashboard Overview on page 47

e Enabling the Real-Time Monitor and AppFlow Collection on page 47

Dashboard Overview

The Visualization Dashboard offers an effective and efficient interface to visually monitor your network in real
time by providing effective flow charts of real-time data, customizable rules, and flexible interface settings. With
the Visualization Dashboard, you can efficiently view and sort real-time network and bandwidth data to:

e |dentify applications and websites with high bandwidth demands
e View application usage on a per-user basis

e Anticipate attacks and threats encountered by the network

@ TIP: For easy viewing, display a Dashboard report or chart in a new browser tab, then move the tab to a
new browser window separate from the management window by clicking on the Display icon next to the
submenu item of interest.

Enabling the Real-Time Monitor and AppFlow
Collection

The real-time application monitoring features rely on the flow-collection mechanism to collect and display data.
Before you can view the applications chart in the Real-Time Monitor, AppFlow Monitor, or AppFlow Reports, you
must first enable and configure the flow-collection feature.
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sppFow /. Flow Reporting

To enable Real-Time Monitoring and Internal AppFlow collection:

1 Navigate to the AppFlow > Flow Reporting page.

Cancel Clear Default

Statistics Settings GMSFlow Server

External Flow Reporting Statistics "

Connection Flows Enqueued:

Connection Flows Dequeued:

Connection Flows Dropped:

Connection Flows Skipped Reporting:
Hon-Connection data Engueuved:
Hon-Connection data Dequeued:

e ion data pped
Hon-connection related static data Reported:

Total IPFIX Statistics

Total NetFlow/IPFIX Packets Sent:

HetFlow/IPFIX Packets Sent to External Collector:
HetFlow/IPFIX Packets Sent to GMSFlow Server:
HetFlow/IPFIX Packets Sent to AppFlow Server:
Hetflow/IPFIX Templates sent:

‘Connection Flows Sent to External Collector:
Connection Flows Sent to GMSFlow Server:
Connection Flows Sent to AppFlow Server:

2 Click the Settings tab.

Statistics Settings

Settings i

Report Connections

Enable Real-Time Data Collection
Collect Real-Time Data For

Enable Aggregate AppFlow Report Data Collection
Collect Report Data For

Local Server Settings 3

Enable AppFlow To Local Collector 1
Other Report Settings i

Report DROPPED Connection

Skip Reporting STACK Connections
Include Following URL Types

Enable Geo-IP Resolution

AppFlow Report Upload Timeout (sec)

AppFlow Server

o ool oo oo

o oo ololo oo

GHMSFlow Server

AppFlow Server

External Collector

Internal AppFlow Reporting Statistics

Data Flows Enqueued: 1]
Data Flows Dequeued: 1]
Data Flows Dropped: 1]
Data Flows Skipped Reporting: 1]
General Flows Engueued: 1]
General Flows Degueuved: 1]
General Flows Dropped: 1]
General Static Flows Dequeued: 253
AppFlow Collector Errors: 1]
Total Flows in DB: a

Total IPFIX Statistics

Non-Connection related Dynamic Flows Sent to
External Collector:

Non-Connection related Dynamic Flows Sent to
GMSFlow Server:

Non-Connection related Dynamic Flows Sent to
AppFlow Server:

Non-Connection related Static Flows Sent to External
Collector:

Non-Connection related Static Flows Sent to GMSFlow
Server:

Non-Connection related Static Flows Sent to AppFlow
Server:

External Collector

@ Al () Interface-bazed (| Firewall/App Rules-based
n

|Top appe, Bits per sec., Packets per zec., Average packet size, Connections per g
@ Al

lﬂpps Report, User Report, IP Report, Threat Report, Geo-IF Report, URL Report =

D‘

1
Fil

kSifs, Jpegs, Pngs, Himls, Aspx |
~

120

~

3 Select the Enable Real-Time Data Collection checkbox. This checkbox is selected by default.

4 Select from the Collect Real-Time Data For drop-down menu the reports you would like to see captured
(all are selected by default):

e Top apps

SonicWall SonicOS 6.2 Administration Guide
Using the SonicOS Visualization Dashboard



e Bits per sec

e Packets per sec

e Average packet size
e Connections per sec
e Core util

5 Select the Enable AppFlow To Local Collector checkbox.
@ | NOTE: Enabling this setting requires the system to be rebooted.

6 To enable these reports, click the Accept button to save your changes.

7 Navigate to the Network > Interfaces page.

network | Interfaces

@ Accept

Interface Settings ViewIP Version: @ 1pv4 Oy [+]

Group IP Address Subnet Mask IP Assignment 5 Enabled  Comment Configure

X0 LAN 192,168,168, 168 255.255.255.0  Static No link @ DefaultLaN (&)
X1 WAN DefaultlB Group 10.203.28.26  255.255.255.0  Static éf;epi Ful Default WAN (&)
%2 Unassigned 0.0.0.0 0.0.0.0 NJA No link @
X3 Unassigned 0.0.0.0 0.0.0.0 NJA No link @
X4 Unassigned 0.0.0.0 0.0.0.0 NJA No link @
¥5 Unassigned 0.0.0.0 0.0.0.0 N/JA No link 'S:?)
X6 Unassigned 0.0.0.0 0.0.0.0 MfA Mo link 'S:?)
X7 Unassigned 0.0.0.0 0.0.0.0 NJA No link @
MEMT® MGMT 192,168.1.254  255.255.255.0  Static No lirk Defauilt MGMT
Add Interface...

8 Click the Configure icon for the interface you wish to enable flow reporting on. The Edit Interface
window displays.

| General | Advanced |

Interface "X0" Settings

Zone: | LAN -
Mode / IP Assignment: Static IP Mode -
IP Address: 192.168.168.168

Subnet Mask: 255255255.0

Default Gateway (Optional): 0.0.00

Comment: Default LAN

Management: HrPs [ ping [ smp 9] ssH
User Login: HTTP HTTPS

Add rule to enable redirect from HTTP to HTTPS
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9 Click the Advanced tab.

General Advanced

Advanced Settings

Link Speed: Auto Negotiate -

@ Use Default MAC Address: COEAE459B2D6

@ Override Default MAC A Enable flow reporting on flows
created for this interface

Shutdown Port

Enable flow reporting N

Enable Multicast Suppart
Enable 802, 1p tagging "

Allow duplicate MAC addresses N

Exclude from Route Advertisement (NSM, OSPF, BGP, RIF) N
Nane -

Redundant/Aggregate Ports:

Expert Mode Settings

Use Routed Mode - Add NAT Policy to prevent outbound/inbound translation
|An3.r -

MAT Policy outhoundfinbound interface:

Interface MTU: 1500

10 Ensure that the Enable flow reporting checkbox is selected.
11 Click the OK button to save your changes.
12 Repeat Step 8 through Step 11 for each interface you wish to monitor.

For more detailed information on configuring Flow Reporting settings, refer to Dashboard > AppFlow Reports on
page 89.
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Monitoring Multi-Core Usage

e Dashboard > Multi-Core Monitor on page 51
e Multi-Core Monitor Display for High Availability on page 52

Dashboard > Multi-Core Monitor

@ NOTE: For increased convenience and accessibility, the Multi-Core Monitor can be accessed from the
Dashboard > Multi-Core Monitor, Dashboard > Real-Time Monitor, or System > Diagnostics page. The
Multi-Core Monitor display on the System > Diagnostics page is identical to that of the Dashboard >
Multi-Core Monitor. Both monitors display information about single cores. The Dashboard > Real-Time
Monitor shows the information either for combined data in flow chart format or for individual cores in bar
chart format.

If your system is configured for high availability, the cores for both the Primary and Secondary firewalls are
displayed.

TZ Series, NSA Series, SuperMassive Series display

Dzshboard | Multi-Core Monitor

Multi-Core Utilization
Data Plane: 1.00% Control Plane: 8.00%

4 x 800 MHz Mips64 Octeon Processor

18 12 8 4 2 2 1

Core Mumber

MNote: High utilization on Core 1is normal while browsing the web management interface and applying changes.
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SuperMassive 9800 display

Dashbozrd . Multi-Core Monitor

Multi-Core Utilization Data Plane: 0.00% Control Plane: 0.00%
64 x 1200 MHz Mips64 Octeon Processor 4

B4 =] 56 B2 48 44 40 28 22 28 24 20 16 12 k] 4 1

Core Number

Mote: High utilization on Core 1is narmal while browsing the web management interface and applying changes.

The Multi-Core Monitor displays dynamically updated statistics on utilization of the individual cores of the
SonicWall network security appliance; for:

e TZSeries, NSA Series, or SuperMassive Series: 18 to 32, with Core 1 through Core 8 handling the control
plane and the remaining cores handling the data plane

e SuperMassive 9800: 2 control plane cores and 62 data plane cores

The number of cores depends on the model of the appliance. The control plane(s) usage is displayed in green
and the data plane cores in blue.

To maximize processor flexibility, functions are not dedicated to specific cores; instead all cores process all data
plane tasks. Memory is shared across all cores. Each core processes a separate flow, and all cores can process
their flows simultaneously, simultaneously, thus allowing for up to 88 flows, or 62 flows for the SuperMassive
9800, to be processed in parallel.

@ NOTE: High utilization on the control plane cores is normal while browsing the web management interface
and applying changes. All web management requests are processed by the control plane cores and do not
impact the other cores. Traffic handling and other critical, performance-oriented and system tasks are
always prioritized by the scheduler, and are never impacted by web management usage.

Multi-Core Monitor Display for High Availability

If your system is configured for high availability, the cores for both the Primary and Secondary firewalls are
displayed. To view the two monitors side by side, click the small triangle in the header of the first monitor.
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High Availability display

Dashbozrd . Multi-Core Monitor

Multi-Core Utilization - Primary (Active)
Data Plane: 10.32% Control Plane: 96.00%

64 x 1200 MHz Mips64 Octeon Processor

a3 59 55 51 47 43 29 35 31 27

Core Mumber

Multi-Core Utilization - Secondary (Standby)
Data Plane: 0.17% Control Plane: 14.00%

64 x 1200 MHz Mips64 Octeon Processor

a3 59 55 51 47 43 32 35 3 ar

Core Number

Mote: High utilization on Core 1is normal while browsing the web management interface and applying changes.

High Availability display side-by-side

Dashbozrd /. Multi-Core Monitor

Multi-Core Utilization - Primary (Active)
Data Plane: 10.60% Control Plane: 97.00%

64 x 1200 MHz Mips64 Octeon Processor

Multi-Core Utilization - Secondary (Standby)
Data Plane: 0.17% Control Plane: 7.00%
64 x 1200 MHz Mips64 Octeon Processor

100% 100%
90% 90%
20% 20%
T0% T0%
80% 80%
50% 50%

40%
0%
20%
10%

0%

Core Number

47

a9 el 23 15 T

Core Number

Mote: High utilization on Core 1is normal while browsing the web management interface and applying changes.
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Monitoring Real-Time Traffic Statistics

@ | NOTE: The Real-Time Monitor feature is available on TZ series and above appliances.

e Dashboard > Real-Time Monitor on page 55

Configuring the Real-Time Monitor on page 56
Using the Toolbar on page 57

Common Features on page 58

Applications Monitor on page 63

Bandwidth Monitor on page 64

Packet Rate Monitor on page 65

Packet Size Monitor on page 66

Connection Count Monitor on page 68

Multi-Core Monitor on page 69
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Dashboard > Real-Time Monitor

The Real-Time Monitor provides an inclusive, multi-functional display with information about applications,
bandwidth usage, packet rate, packet size, connection rate, connection count, and multi-core monitoring.

®

NOTE: A chart may be empty or blank if there are no recent data entries received within the viewing
range.

Dashbozrd | Real-Time Monitor

To configure, go to AppFlow > Flow Reporting.  [Using Local Collector] 15:41:29 Aug 08

10 minutes

Refresh E\rery: SEC. ‘ Q @ View Range:

&0 0Fbp=

Applications # IPvdand IPVE v Al Apps | AutoV¥-Scaing I 2

50.0Fbp=

40 0Ebp=

30. 0Ebp=

20. 0Ebp=

10.0Fbps

Obp=

% Legends

General HTTPS
|| MGMT Ml Service DRP Ml General HTTPS Ml Service NTP M| General DNS

ao.okep= | Ingress Bandwidth # | Current Ave: 14,3 Kbps Min: 5.7 Kbps Max: 577.3 Kbps
1
1Pv4 and IPVE Auto Y-Scaling

20 0Fkbp=
20 ogmp Egress Bandwidth # Current Ave: 10.8 Min: 5.0 Kbps Max: 1.7 Mbps
15:32 15:33 15:34 15:35 15:3€ 15:37 15:38 15:39 15:40 15:41
£ Legends
| X0 X1 | X2 X3 M x5 MGMT
=

4_0Fp=

2.07e= | Ingress Packet Rate? [ current Ave: 1Pps Min: 1 Pps Max: 238 Pps |

2. Auto Y-Scaling

10.08p= Q
15 0mm Egress Packet Rate # | Current Ave: 4 Pps Min: 1Pps Max: 755 Pps
15:13 15:14 15:15 15:16 15:17 15:18 15:18 15:20 15:21 1s:22
£ Legends
o X0 W X1 X2 o X3 [ B MGMT
=

5.0EB

#-0F% | Tngress Packet Size 7 Current Ave: 1518 Bytes Min: 34 Bytes Max: 1518 Bytes |

3.

N Auto¥-Scaing

1.

500.0B
1.
1.5EB —
R Egress Packet Size * Current Ave: 378 Bytes Min: 183 Bytes Max: 1518 Bytes
1s5:13 15:14 15:15 1s5:1€ 15:17 1s5:18 15:19 15:20 1s5:21 is:22
% Legends
M X0 M x1 M X2 M x3 M x5 MGMT
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Z00lps

Connection Rate Current Ave: 120 Cps Min: 1 Cps Man: 379 Cps |
ol Interfaces Rate v | [#ato ¥-5oaling | ul [EE

1filps

1nocps

Siips

s
10: 47 10: 43 10: 49 1050 10:51 10: 52 10:53 10:54 10: 55 10: 56

F Legends

1SKC

Connhection Count Current: 12859 Max: 3000000 Ao ¥-Sealing

10KC

10: 47 10: 43 10: 49 1050 10:51 10: 52 10:53 10:54 10: 55 10: 56
=
loo.0
Multi-Core Monitor Total Util:  11% Current Ave: 47% Min: 1% Max: 123 |
foument (Aggregare)  w | [100% | [ F52
T80
s0.0
Z5.0

10:43 10050 10051 Lo: 52 10:53 10:59 10:55 10:56 10057 1056

Topics:
e Configuring the Real-Time Monitor on page 56
e Using the Toolbar on page 57
e Common Features on page 58
e Applications Monitor on page 63
e Bandwidth Monitor on page 64
e Packet Rate Monitor on page 65
e Packet Size Monitor on page 66
e Connection Rate Monitor on page 67
e (Connection Count Monitor on page 68

e Multi-Core Monitor on page 69

Configuring the Real-Time Monitor
The first time you access the Real-Time Monitor, it is disabled:

Dashbozrd /. Real-Time Monitor

ét\'ReaI—'I’lme Monitor is disabled, To configure, please chedk this box |,
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To enable the Real-Time Monitor and start displaying statistics in the different monitors, select the checkbox.

Using the Toolbar

The Real-Time Monitor Toolbar contains features to specify the refresh rate, export details, configure color
palettes, change the amount of data displayed, and pause or play the data flow. Changes made to the toolbar
apply across all the data flows.

Dashboard /. Real-Time Monitor

To configure, go to AppFlow > Flow Reporting.  [Using Local Collector] 13:14:56 Aug 08

Refresh every: K] ec. 9 @ e e 10 minutes v

Real-Time Monitor toolbar options

Option Widget Description

Refresh rate - Determines the frequency at which data is refreshed. A
Refresh every: SEC. . . . .
numerical integer between 1 to 10 seconds is required.
The default is 3 seconds.

Export Exports the data flow into a comma-separated variable
(.csv) file. The default file name is sonicflow.csv.

Print Exports the data flow to a printer.

Configure Displays the Settings window for customization of the

color palette and legend location for the Application Chart
and Bandwidth Chart.

x

To customize the Color Palette:

1 Enter the desired hexadecimal color codes in the
provided text fields.

2 If a gradient is desired, select the Use Gradient
checkbox located below the text fields.

3 Click Default for a default range of colors.
4 Click Generate to generate a random range of
colors.

To change the location of the legend to inside the chart
instead of the default location below the chart:

1 Select the appropriate checkbox:

e Put legends inside Application chart

e Put legends inside Bandwidth chart

2 Click Save to apply the changes.

NOTE: Changing any of the options restarts display of all
the charts.

View Range T ye— = Displays data pertaining to a specific span of time. Two

minutes is the default setting for the view range.

60 seconds

5 minutes
10 minutes
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Real-Time Monitor toolbar options

Option

Widget

Description

Data Source

petasource: [KTCIED
Local
AppFlow Server

GMSFlow Server

Displays data collected from a specific server. The default
setting is Local.

e Select Local to display AppFlow data from an
internal server on your firewall.

e Select AppFlow Server to display AppFlow data
collected by an external AppFlow server.

e Select GMSFlow Server to display AppFlow data
collected by a GMSFlow server.

Using Collector

[Using Local Collector]

Displays the data source (collector).

Time & Date 14:78:16 Jan 07 Displays the current t.lme in 24-hour format (hh:mm:ss),
and the current date in Month/Day format.

Pause @ Freezes the data flow. The time and date will also freeze.
The Pause button appears gray if the data flow has been
frozen.

Play Unfreezes the data flow. The time and date will refresh as

O

soon as the data flow is updated.
The Play button appears gray if the data flow is live.

Common Features

Topics:

e Collapse/Expand Buttons on page 59

e Legends on page 59

e Tooltips on page 60

e Changing Chart Format on page 60

e Scaling a Chart on page 62

e Selecting IPv6/IPv4 on page 62

e Current Average, Minimum, Maximum Display on page 63
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Collapse/Expand Buttons

Directly above each chart, at the far right, is a minus sign button, [5], that collapses the chart when it is clicked.
When a chart is collapsed, a plus sign, [#), is displayed, which expands the chart when it is clicked. Collapsing
charts is useful when you want to compare other charts closer together.

£0. 0Ebps

Ingress Bandwidth # | Current Ave: 13,2 Kbps Min: 5.5 Kbps Max: 4315 Kbps
1Pv4and IPve v MRl Interfaces Rate, Auto F-Sezling [ 7

40 0Fbps=

20. 0Fbps

BEg:
5.0Ebps
10.0Ebps
15.0Ebps
20.0Ebps

Egress Bandwidth ? | Current Ave: E.5 Kbps Min: £.5 Kbps Max: 1.6 Mbps

16:35 1€:3€

2.ore | Ingress Packet Size ? | Current Ave: B34 Bytes Min: 1£3 Bytes Max: 1518 Bytes |

2,058 [l nefoces Sz v | Ao V-Scsing I )
B
1.0FKE

Egress Packet Size ? | Current Ave: 553 Bytes Min: 224 Bytes Masx: 1420 Bytes |

Legends

For most charts, you can display a legend that shows the name and color used for the applications or interfaces
selected in the chart’s Display menu. To display or hide the legend, click on the Legends [z Legends | button below
the chart.

£ Legends
General HTTPS Service RPC X
[ | MGMT Services (TANA) Bl General DNS M Service NTP I General HTTPS General NETBIOS
£ Legends
I x0 I X1 I X2 M X3 | X4 x5 M X& M X8 W X9 M x10
¥11 ¥12 M %13 M x14 | X15 W 16 W x17 M 18 M %19 I x20
B %22 W x23 Wl MGMT

@ NOTE: If you selected to have the legends for the Applications and Bandwidth charts displayed within the
charts, the Legends button has no effect on their display.

SonicWall SonicOS 6.2 Administration Guide
Monitoring Real-Time Traffic Statistics



Tooltips

Various elements of the charts have associated tooltips:

e The name of the chart has a Tooltip (# icon that briefly describes the chart.

- e

General HTTPS o o a1| Ingress Bandwidth

MGMT Tragress bandwidth chart is plotted Iy collecting
cument incoming data rate (bits per sec) for each
iinterface eveny refresh pariod.

Ingress Bandwidth ¥ [ CormentAves %4 i

Miri; 3.7 Kigs

Egress Bandwidth * [ Current Bve:

18:0% 18:0€ 18:07 lg:08

e Legend items display information about the item the legend represents.

3.0EE
ize ¥ :
2oz | Ingress Packet Size Curment Ave:
1.0KE
Xo
Zone: LAN
504
, 152,168, 168,168 O
. [PAddm'feS'D::clez:ettH:felc:blbl-'l{l
| status: Mo link e
1.| In Siza: 0 Bytes —
Out Size: 0 Bytes
= Leg|
i M X1 2

e A small circle displays information about a precise moment on the chart.

‘Connection Count *

To display a tooltip, hover your mouse over the desired item. The information displayed varies by chart.

Changing Chart Format

You are able to view individual charts in either bar chart format or flow (area) chart format. Each chart has Chart

Format [l [R=] icons in the upper right corner of the chart. The default is flow chart format.

Topics:
e Bar Chart on page 61
e Flow Chart on page 61
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Bar Chart

The bar chart format displays applications individually, thus allowing you to compare applications. In this chart,
the applications, interfaces, or core monitors are arranged along the x-axis, for applications and interfaces

according to the color code shown in the Legend. The y-axis displays information appropriate to the chart, such
as the amount of traffic for each application or interface. To display the data in bar chart format, click on the Bar

Chart [ul] icon. The following example is a Bar Chart view.

2.0mm
1.1%= | Ingress Packet Size® | Cumentive: 1504 Byt Min: 96 Bytes Max: 1518 Byt o et e [ — W~
1 | 1 1 1 1 1 1 1
su0.08 | | | |

L

20008

400.0B

Egress Packet Size Min: 250 Syl=x Max: 1413 Byl=s

£00.0E

T

Intasfacas

| dutio Y-Scaiing 1

Flow Chart

The flow chart format displays over-lapping data in a stacked format as it occurs. In this chart, the x-axis displays
the current time and the y-axis displays information appropriate to the chart, such as the amount of traffic for
each application or the rate or size of the packets. To display data in the flow chart format, click the Flow Chart

[#]icon.
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The following example is a Flow Chart view.

/' Real-Time Monitor

To configure, go to AppFlow > Flow Reporting.  [Using Local Collector] 15:41:29 Aug 08

=

€0. 0Fbp=

s0_orup- | APPlications ? IPvdand IPVE All Apps - | Auto'¥-Scaing [ P

40.0Fbps

30 0Ebp=

20. 0Ebp=

10.0Ebps

Okp=
1s5:3z2 15:33 15:34 15:35 15:36€ 15:37 15:38 15:3% 15:40 15:41

= Legends
General HTTPS

|| MGMT Ml Service DRP Ml General HTTPS Ml Service NTP M| General DNS

40.0Fbps

30.oeep= | Ingress Bandwidth # | Current Ave: 14.3 Kbps Min: 8.7 Kbps Max: 577.3 Kbps
-

20.0Fbp= Aurto Y-Scaling

10.0Fkps
22

10.0Ebps

20. 0Fbp=
J— Egress Bandwidth 7 Current Ave: 10.8 Kbps Min: 5.0 Kbps Max: 1.7 Mbps
. =
15:32 15:33 15:34 15:35 15:3€ 15:37 15:38 15:39 15:40 15:41
% Legends
M X0 X1 X2 X3 M Xe MGMT

Scaling a Chart

The Scale box, wsmrzcaing , in the upper right corner of a chart, allows for Auto Y-Scaling or custom scaling of
a chart:
e Auto (default) — Auto Y-Scaling

e <num>[<unit>] — The values for customized scaling must be a numeric integer. Specifying a unit is
optional. If a unit is desired, four options are available:

e KforKilo.
e M for Mega.
e G for Giga.

e % for percentage.

For example, if a custom scale of 100Kbps is desired, then 100K should be entered: The numeric integer
100 followed by the unit K.

@ | NOTE: An invalid entry results in the default, Auto Y-Scaling, being used.

Selecting IPv6/1Pv4

For complete information on the SonicOS implementation of IPv6, see IPv6 on page 2171.

@ | NOTE: This option applies only to the Applications and Ingress/Egress Bandwidth charts.
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Real-Time Monitor Visualization is configured the same in IPv6 and IPv4; select a radio button in the drop-down
menu to change the view/configuration:

Pt 2nc 1P -
%]

) 1 oy

® .

et 1P Oy

@ psare1ms

e |Pv4 Only
e |Pv6 Only
e |Pv4 and IPv6

Current Average, Minimum, Maximum Display

All charts, except Applications, Connection Count, and Multi-Core Monitor, display the current average,
minimum, and maximum values for the chart. The values vary by chart and can be in Kbps, Pps (packets per
second), Bytes, or Cps (connections per second).

[ Cument A 131 Kig= Miri: 6.7 Kig= Max: 3239 Kig= |

For the Ingress/Egress charts, the information is displayed for both halves, the Ingress on the top and the Egress
on the bottom. For the other charts, the information is displayed on the top.

Applications Monitor

The Applications data flow provides a visual representation of the current applications accessing the network.

=]
EO0.OKBpa
fr Agpplications * Ty v T premerauenize S R PRr—— [
a0 ompa
e Ganeral HTTPS MGMT - 32,547 Kbps

= Legends
Genersl HTTPS
MGMT

Bar Chart

DEmpa
ications ¢ Paams v| i peeFeetioe w| movEcing |
nxepa
15 0xmpa o
10.0Empe
ox=p
2 Legends
Ganarsl HTTRS g
MGMT | General DNS
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Options

The following options are specific to the Applications chart. For other options and display features, see
Common Features on page 58.

Applications chart options

Option Widget Description

Lock i Locks the Display for the Applications chart. The
lock/unlock option is available when you select Most
Frequent Apps. Most Frequent Apps displays the top-25
apps; you can use the lock or unlock option to keep the
report from altering the top-25 apps.

Unlock -"-. Unlocks the Display for the Applications chart.
Application Display r— Specifies the applications displayed in the Application
s o Flow Chart.
[ e A drop-down menu allows you to specify Most Frequent
W'"mm Apps, All Apps, or individual applications. If desired,
5"‘“”“" multiple applications can be selected by clicking more
::;E than one check box.
GHH?IDNS

Bandwidth Monitor

The Ingress and Egress Bandwidth data flow chart provides a visual representation of incoming (Ingress) and
outgoing (Egress) bandwidth traffic. The current percentage of total bandwidth used, average flow of bandwidth

traffic, and the minimum and maximum amount of traffic that has gone through each interface is available in
the display.

® | NOTE: The Bandwidth charts have no direct correlation to the Application charts.

Flow Chart

The flow chart format overlaps the Bandwidth Interfaces; allowing you to view all of the Ingress and Egress

Bandwidth traffic as it occurs. The x-axis displays the current time, and the y-axis displays the Ingress and Egress
Bandwidth traffic.

15.0xxps | Ingress Bas idth ¢ Cusrrent Ave: 115 die= Min: £7 ¥boe M 3235 o [Pazcme w | [lmscasrae M w | fumo YScaiing m

Egress Bandwidth © [ Coment Ave: 23 Ko Min: 5 Kooe Max: 24 Mooe
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Bar Chart

The bar chart format displays data pertaining to individual interfaces in a bar chart; allowing comparisons of
individual Bandwidth Interfaces. In this chart, the x-axis denotes the Interfaces whereas the y-axis denotes the
Ingress and Egress Bandwidth traffic.

2.0Gbps

Ingress Bandwidth Current Ave: 2.5 Ghps Min: 2349 Mbps Max: 2.6 Ghps |
I B I I |.¢\II Intetfaces Rate - | |A.rto ¥-Sealing | i"! e

Z.0Gbp=

1.0Gbps=

8 o

1.0Gbps

z.0ebp= | Egress Bandwidth | Current Ave: 2.5 Gbps Min: 2445 Mbps Mas: 2.6 Ghps

2_0Ghps
0 - oz s e w0 Bl 1z B0 13 B xz1 B FABRIC
B MGMT

Options

Options are available to customize the Display, Scale, and View of the Ingress and Egress Bandwidth charts. The
following option is specific to the Bandwidth chart. For other options and display features, see Common
Features on page 58.

Ingress and Egress Bandwidth chart options

Option Widget Description
Interface Rate Ty Specifies which Interfaces are displayed in the Bandwidth
Display 7] s 1otmctmcmc e, > Flow Chart.
] Po—— A drop-down menu provides options to specify All
] — Interfaces Rate, All Interfaces (%), or rate or percentage
[0 (%) for individual interfaces.
M e a2 The individual interfaces vary depending on the number
(s s 1 of interfaces on the network. Multiple interfaces can be
Mz meee selected if desired.
32\:"-!5\}-
Ekh:
[ B
ws-n:u:
(s 2l
« [Lmg] v

Packet Rate Monitor

The Packet Rate Monitor provides information on the ingress and egress packet rate as packets per second
(pps). This can be configured to show packet rate by network interface. The chart shows the packet rate current
average, minimum packet rate, and maximum packet rate for both ingress and egress network traffic.
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Flow Chart

200.0EPps=

Current Awve: 245337 pps

Man: ZESFEZ pps
FAuto - Sealing

200 0KPp=

100.0EPE=

o.op
]

100 0FFp= x2 - 45861 Pps

Z00.0KPp=
Current Ave: 242432 pps Min: 23912 pps Max: 284359 pps
200.0KFps
11: 25 11::29 11:20 11:31 11::22 11:3:z2 11: 34 11::25 11: 26 11::37

% Legends

M 0 Iz s s w10 Il =1z B0 %13 B xz1 Bl FABRIC

L leg
Z00.0EFPp=
150 0kPps Ingress Packet Rate | Current Ave: Z389EE pps Min: 20140 pps Mau: ZEITEZ pps

P‘-\II Interfaces Rate - | |ﬁd.rto ¥-Sealing | W]

100 0EFPp=

50 0EFps

o.0PEg £ E

L | i
E0.0EFE=

100_0EPp= X21

150_axpps | EOVss Packet Rate [ cCurrent Ave: 232034 py| ZONE: LAM Ma: 264359 pps
IP Address: 192,1658,170,170

200.0KFps Status: Up

£ Legends

2=
M 20 B3N [E=d [FEE (B w10 Bl %12 B0 213 B =21 Bl FABRIC
B MGEMT
i
Options

Options are available to customize the Display, Scale, and View of the Ingress and Egress Packet Rate charts. For
the options and display features, see Common Features on page 58.

Packet Size Monitor

The Packet Size Monitor provides information on the ingress and egress packet size in bytes (B). This can be
configured to show packet size by network interface. The chart shows the packet size current average, minimum
packet size, and maximum packet size for both ingress and egress network traffic.
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Flow Chart

.25z | Ingress Packet Size * [ Curment Ave: DEam Min: 25 Byims Maox: 1533 Byims fur treervcas e EE v — [ TR

=]
1.mxm -
I
. uxa | Ingress Packet Size® | Comentive: 1413 Byt Min: 35 Sy Max: 1508 Sy e amrraces e [ — W]
u_te
i =
o.m Q
l.0xB -
. Egress Packet Size * Cument Ave: 1143 Byl== Min: 130 Syi= Maos 1518 Byl=s
Intasfacas
= Legends
. X0 X1 2 e X6 MGMT

Options

Options are available to customize the Display, Scale, and View of the Ingress and Egress Packet Size charts. For
the options and display features, see Common Features on page 58.

Connection Rate Monitor

The Connection Rate Monitor is plotted by collecting the outgoing and incoming connection rates for each
interface every refresh period. When looking at the combined connection rate of more than one interface at the
same time, it may appear double than the actual connection rate. A single connection between a pair of
interfaces is counted for both interfaces.

Flow Chart

Connection Rate ? Current Ave: 0 Cps Min: 1Cps Max: & Cps
+o0ces |All Interfaces Rate v | Auto¥-Scaing ul

0Cps
17:53 17:54 17:55 17:56 17:57 17:58 17:58 18:00 18:01 18:02

£ Legends
| [E0] X1 o X2 M X3 M x4
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Bar Chart

1.2Cps

Connection Rate? [ current Ave: 1Cps Min: 1Cps Max: & Cps |

4l Interfaces Rate w | Auts¥-Scaing

1_00p=

0.8Cps

0.6Cps

0.4Cps

0.20ps

0cps
% Legends

[ [ x1 () x2 ([ x3 (| x4

Options

Options are available to customize the Display, Scale, and View of the Connection Rate charts. For the options
and display features, see Common Features on page 58.

Connection Count Monitor

The Connection Count Monitor provides a visual representation of the current total number of connections,
peak number of connections, and maximum number of connections. The y-axis displays the total number of
connections from OC (zero connections) to 1KC (one kilo connections). The default auto scaling is 100K.

Flow Chart

=
80.0C
Connection Count? [ Current: = Peak: 22 Max: 43152 Auto V-Bosing [
€0.0C
40._0C
20.0C
oc
18:03 18:0% 18:05 18:0€ 18:07 18:08 1B8:0%9 18:10 18:11 18:12
=

Connection Count 2 Current: & Peak: B Max: 43152 Puto Y-Scaling
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Options

Options are available to customize the Display, Scale, and View of the Connection Count charts. For the options
and display features, see Common Features on page 58.

@ | NOTE: The Connection Count Monitor does not have legends.

Multi-Core Monitor

@ NOTE: For increased convenience and accessibility, the Multi-Core Monitor also can be accessed from the
Dashboard > Multi-Core Monitor, Dashboard > Real-Time Monitor, or System > Diagnostics page. The
Multi-Core Monitor display on the System > Diagnostics page is identical to that of the Dashboard >
Multi-Core Monitor. Both monitors display information about single cores. The Dashboard > Real-Time
Monitor shows the information either for combined data in flow chart format or for individual cores in bar
chart format.

The Multi-Core Monitor displays dynamically updated statistics on utilization of the individual cores of the
firewall. Core 1 through core 8 handle the control plane. Core 1 through core 8 usage is displayed in green on
the Multi-Core Monitor. The remaining cores handle the data plane. To maximize processor flexibility, functions
are not dedicated to specific cores; instead all cores can process all data plane tasks. Memory is shared across all
cores. Each core can process a separate flow simultaneously, allowing for up to 88 flows to be processed in
parallel.

Flow Chart

The flow chart format overlaps the Multi-Core Monitor data. The x-axis displays the current time, and the y-axis
displays the percentage of CPU used.

z0.0 | Multi-Core Monitor | Total Ukil:  32.417% Current Ave: 31.193%  Min: 12.927%  Max: 40.635% |

F:urrent [Aggregate] - | |1IJ|J“;€ | IEE]
g0
a0._10

20,

lz:05 lz:08 L2005, 12:08 1z:09 lz:10 12:11 otk 1212 12+:1d

Bar Chart

The bar chart format displays data pertaining to individual cores. The x-axis displays the cores while the y-axis
displays the percentage of CPU used.

100 0%

Multi-Core Monitor [ TotalUtil:  30.185% Current Ave: 31.199%  Min: 12.927%  Max: 40.635% |

1005 [T~
50%

S0.0%

O

25 0%

e k] &0 e 53 113 45 40 22 24 1e g 1
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Options

Scale and View are options available to customize the Multi-Core Monitor interface. The following option is
specific to the Multi-Core chart. For other options and display features, see Common Features on page 58.

Multi-Core Monitor options

Option Widget Description
Aggregate Display T Specifies which Cores are displayed in the Multi-Core
] . Monitor Flow Chart.
® merages - A drop-down menu allows you to specify Current
® oes (Aggregate), Average (Aggregate), and individual Cores.
[ P 3 The individual Cores vary, depending on the number of
® s Cores available. Multiple Cores can be selected.
IE:::I Core 4
IE:::I Core 5
IE:::I ore &
IE:::I Core 7
IE:::I Core B
IE:::I Core 9
e o
E I T
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Viewing the Top-10 AppFlow Reports

e Dashboard > AppFlow Dash on page 71
e Configuring the Display on page 72

Dashboard > AppFlow Dash

The Dashboard > AppFlow Dash page provides the same information that is provided in Dashboard > AppFlow
Reports. Only in AppFlow Dash, the information is shown in charts for the top one through ten items in each
category. AppFlow Dash displays charts for the following items:

e Top Applications
e Top Users

e Top Viruses

e Top Intrusions

e Top Spyware

e Top URL Ratings
e Top Locations

e Top IP Addresses

@ NOTE: The Botnets category on the Dashboard > AppFlow Reports page does not have a corresponding
chart on the Dashboard > AppFlow Dash page. See Dashboard > AppFlow Reports on page 89.

The following graphic shows the first two charts on the AppFlow Dash page. The charts for the other categories
are similar.

Dashbozs | AppFlow Dash

UPTIME:

view: XTI ) S

Top Applications View by: Sessions o (2] Top Users View by: ByiesRovd o ()
Application Name Percentage of Applications User Mame Perentage of Users
Generzl HTTPS MGMT 75.43% e admin 55.66% -
General DNS 9.85% - UNKNOWN 4,349 u
Service S5O Agent 1 5.78% -
Genersl NETEIOS 0.40%
General HTTPS 0.29%
Service NTP 0.15%
Service DRP 0.08%
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Configuring the Display

Topics:
e Configuring Length of Data Collection on page 72
e Configuring Aggregate Reporting on page 72
e Specifying the Data Source on page 72

e Selecting How to View Individual Charts on page 72

Configuring Length of Data Collection

The toolbar displays the length of time the data have been collected:

View: ETITENTR () S

You can specify the length of time the data displayed in the charts have been collected by selecting the start
time in the View drop-down menu:

e Since Restart
e Since Last Reset

You can refresh the display of:

e The page by clicking the Refresh 3' icon next to the View drop-down menu.

e Just one chart by clicking the Refresh icon for that chart.

Configuring Aggregate Reporting

A green Status (/) Status | icon indicates that aggregate AppFlow reporting is enabled. Mousing over the Status
icon displays a tooltip with a link to AppFlow > Flow Reporting, where you can enable, disable, and configure
Aggregate Appflow reporting.

Specifying the Data Source

You can specify the source of the data in the Data Source drop-down menu:
e Local
e AppFlow Server

e GMSFlow Server

Selecting How to View Individual Charts

You can select the way to view a chart’s data by a drop-down menu in the chart’s title bar:

e Top Applications and Top Locations charts:
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e Sessions—Number of connections/flows
e Init Bytes—Number of bytes sent by the initiator
e Resp Bytes—Number of bytes sent by the responder
e Top Users and Top IP Addresses charts:
e Sessions—Number of connections/flows
e Bytes Rcvd—Bytes of data received by the user/IP address
e Bytes Sent—Bytes of data sent by the user/IP address
e Top Viruses, Top Intrusions, Top Spyware and Top URL Ratings charts:

e Sessions—Number of connections/flows
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7

Monitoring Real-Time Network Data

e Dashboard > AppFlow Monitor on page 74
e AppFlow Monitor Tabs on page 75
e AppFlow Monitor Toolbar on page 76
e Group Options on page 78
e AppFlow Monitor Status on page 79
e AppFlow Monitor Views on page 79
e Filter Options on page 84

e Generating Application Visualization Report on page 86

Dashboard > AppFlow Monitor

The AppFlow Monitor provides real-time, incoming and outgoing network data. Various views and customizable
options in the AppFlow Monitor Interface assist in visualizing the traffic data by applications, users, URLs,
initiators, responders, threats, VolP, VPN, devices, or contents.

|—|+ ———— |._.,a,dﬁ|,,e.._ - Selectlnput Fiter -+ |[1]] | %
Data Source: QS -
Applications Users URLs Initiators Responders Threats VoIP VPN Devices Contents
Create Rule | Fliter View  Interval: LastS0zzconds o Group  Applicztion w IPVersion: [Pud &Py E GE %) (&) (% g \;; m

Application Total Packets Ave Rate (KBps) Threats

Mo Entries

up bime: 1 Dy 04:26:16  Report Flows Mode: All last update: 15:55:48 Aug 12

&) AppFlow to Local Collector is Enabled. To configure, go to AppFlow = Flow Reporting,

Topics:
e AppFlow Monitor Tabs on page 75
e AppFlow Monitor Toolbar on page 76
e Group Options on page 78
e AppFlow Monitor Status on page 79
e AppFlow Monitor Views on page 79
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e Filter Options on page 84

e Generating Application Visualization Report on page 86

AppFlow Monitor Tabs

The AppFlow Monitor Tabs contain details about incoming and outgoing network traffic. Each tab provides a
faceted view of the network flow. The data is organized by tabs:

Applications | Users || URLs || Initiators Responders || Threats || VoIP || VPN || Devices || Contents |

AppFlow Monitor tabs

This tab Displays

Applications A list of Applications currently accessing the network.
Users A list of Users currently connected to the network.
URLs A list of URLs currently accessed by Users.

To view this report:
1 Navigate to Firewall > Content Filter Objects.
2 Click the Edit icon for CFS Default Action. The Edit CFS Action
Object displays.
Select the Enable Flow Reporting checkbox.
Click OK.
Navigate to Network > Zones.
Click the Edit icon for the zone to be monitored. The Edit Zone
dialog displays.
7 Select the Enable Client CF Service checkbox.

A U B Ww

8 Click OK.
Initiators Details about current connection initiators.
Responders Details about current connection responders.
Threats A list of threats encountered by the network.
VolP Current VolIP and media traffic.
VPN Alist of VPN sessions connected to the network.
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AppFlow Monitor tabs

This tab Displays
Devices A list of devices currently connected to the network.
Contents Information about the type of traffic flowing through the network.

To view this report:
1 Navigate to Security Services > Intrusion Prevention.

2 Inthe IPS Global Settings section, select the Enable IPS
checkbox.

3 Click Accept.
4 Navigate to Firewall > App Control Advanced.

5 In the App Control Global Settings section, select the Enable
App Control checkbox.

Click Accept.
Navigate to Network > Zones.

8 Click the Edit icon for the zone to be monitored. The Edit Zone
dialog displays.

9 Select the Enable IPS checkbox.

10 Click OK.

AppFlow Monitor Toolbar

The AppFlow Toolbar allows for customization of the AppFlow Monitor interface. The ability to create rules and
add items to filters allows for more application and user control. Different views, pause and play abilities,
customizable data intervals and refresh rates are also available to aid in visualizing incoming, real-time data.
Selecting data by group and configuring the columns displayed on a tab enable refining of the display.

Create Rule || Filter View | Interval: Last60seconds » Group: Application ~ 1P Version: |Pvdand IPvé « [ %X (&) 3 = y Status |

AppFlow Monitor toolbar options

Option Widget Description

Create Rule — Starts the App Control Wizard. For more information on
using this wizard, refer to About App Rules and App
Control Advanced on page 913.

NOTE: General- and service-type applications cannot be
included in a rule.

Filter View Correlates data among the tabs. For more information
about creating a filter, see Filter Options on page 84.
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AppFlow Monitor toolbar options

Option

Widget

Description

Interval

Interval: Last 60 seconds H i
Last 60 seconds
Last 2 minutes
Last 5 minutes
Last 10 minutes
Last 15 minutes
Last 30 minutes
Last 60 minutes
Last 3 hours
Last &hours
Last 12 hours
Last 24 hours
Last 7 days

Last 15 days
Last 30 days

All Flows

Specifies the span of time in which data is collected. The
default is Last 60 seconds.

Group

Group:  Application
Application

Category
Signature i

Categorizes selections according to the available grouping
options, which vary depending on the tab that is selected.
See Group Options on page 78.

IP Version

IF Version:  [Pvd B IPy o

Allows selection of internet protocol: IPv4, IPv6, or both
(IPv4 & IPv6) (default).

List View

Provides a detailed list view of the data flow. See List View
on page 80.

Pie Chart View

Provides a pie chart view of the data flow. See Pie Chart
View on page 83.

Flow Chart View

Provides a flow chart view of the data flow. See Flow
Chart View on page 83.

Export

Exports the data flow in comma separated variable (.csv)
format.

Print PDF Report

Generates an Application Visualization Report. For more
information, refer to Generating Application Visualization
Report on page 86.

Configuration

Customizes the display by enabling or disabling columns
for # (number), Tab subject (such as Applications or VPN),
Sessions, Packets, Bytes, Rate, and Threats. Also enables
or disables commas in numeric fields.

Refresh Button

Refreshes the real-time data display.

Status Update

Provides status updates about App signatures, GAV
Database, Spyware Database, IPS Database, Country
Database, Max Flows in Database, CFS Status, and more.
For more information, see AppFlow Monitor Status on
page 79.
e A green status icon signifies that all appropriate
signatures and databases are active.
e Avyellow status icon signifies that some or all
signature databases are still being downloaded or
could not be activated.

e Ared status icon signifies that the database is not
downloaded or active.

SonicWall SonicOS 6.2 Administration Guide
Monitoring Real-Time Network Data



Group Options

The Group option sorts data based on the specified group. Each tab contains different grouping options.

Group options by tab

This Tab Can be Grouped by Which
Applications Application (default) Displays all traffic generated by individual applications.
Category Groups all traffic generated by an application category.
Signatures Groups all traffic generated by an application signature
Users User Name (default) Groups all traffic generated by a specific user.
IP Address Groups all traffic generated by a specific IP address.
Domain Name Groups all traffic generated by a specific domain name.
Auth Type Groups all traffic generated by a specific authorizing method.
URLs URL (default) Displays all traffic generated by each URL.
Domain Name Groups all traffic generated by a domain name.
Rating Groups all traffic generated based on CFS rating.
Initiators IP Address (default) Groups all traffic generated by a specific IP address.
Interface Groups all traffic according to the firewall interface.
Country Groups all traffic generated by each country, based on
country IP database.
Responders IP Address (default) Groups all traffic by IP address.
Interface Groups responders by interface.
Country Groups responders by each country, based on country IP
database.
Threats Intrusions Displays flows in which intrusions have been identified.
Viruses Displays flows in which viruses have been identified.
Spyware Displays flows in which spyware has been identified.
Spam Shows all flows that fall under the category of spam.
Botnet Displays all flows blocked connecting to/from Botnet servers
All (default) Displays all flows in which a threat has been identified or that
fall under the category of spam.
VolP Media Type (default) Groups VolP flows according to media type.
Caller ID Groups VolP flows according to caller ID.
VPN Remote IP Address (default) Groups VPN flows access according to the remote IP address.
Local IP Address Groups VPN flows access according to the local IP address.
Name Groups VPN flows access according to the tunnel name.
Devices IP Address (default) Groups flows by IP addresses inside the network.
Interface Groups flows by interfaces on the firewall.
Name Groups flows by device name or MAC address.
Contents Email Address (default) Groups contents by email address.

File Type

Groups flows by file type detected.
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AppFlow Monitor Status

The AppFlow Monitor Status tooltip appears when the cursor rolls over the Status button in the toolbar. The
AppFlow Monitor Status provides licensing information, status, and signature updates about App Rules, App
Control Advanced, GAV, IPS, Anti-Spyware, CFS, Anti-Spam, BWM, country databases, Geo-IP blocking, and
Botnet blocking. The tooltip also displays the maximum flows in the database and how AppFlow is enabled. For
easy configuration of the AppFlow Monitor display, the tooltip provides links to the appropriate Ul page for each

item as well as a link to AppFlow > Flow Reporting for configuring AppFlow.

If the AppFlow Monitor Status tooltip is no longer wanted, click close in the upper-right corner.

App Rules:
App Control
Advanced:

Gateway Anti-Virus:

Intrusion
Prevention:

Anti-Spyware:

Content Filtering:
Anti-Spam:
Bandwidth
Management:
Country Database:
Geo IP Blocking:

Botnet Blocking:

Max Flows in DB:

Wes

Yes

Wes

25000

Enzhled N/&
Enzbled Downlozded

abled Downloaded

=d Downloaded
abled Downloaded

/& /&
=zbl=d NJA

MNone  NJA

=abled NJA

' AppFlow to Local Collector is Enabled.
Note: To configurs, go to AppFlow > Flow Reporting.

Firewall = App Rules

Firzwall = App Contral
Advanced

Seowity Services = Gateway
Anti-Virnus

Senwity Services = Intnusion
Prevention

Seowrity Services =
Anti-Spywane

Seowity Services = Contant-
Filter

Anti-Spam = Sattings

Firewall Sattings = BWM

N/A
Seowrity Services = Geo-IP
Filter

Seourity Services = Botnet
Filer

B - e 7 Status
close
To Configure...

Licensed Status Signatures

AppFlow Monitor Views

Three views are available for the AppFlow Monitor: List View, Pie Chart View, and Flow Chart View. Each view

provides a unique display of incoming, real-time data.

Topics:

e List View on page 80

e Pie Chart View on page 83

e Flow Chart View on page 83
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List View

In the List View, each AppFlow tab comprises columns displaying real-time data. These columns are organized
into sortable categories. Some columns are common to all tabs.The VoIP tab, however, also has columns specific
to it. There are tooltips and flow tables associated with some column items.

Durshboard |

AppFlow Monitor

+|F|lar'\|'im ah

Daka Source: (Cjlocal () AppFlom Server

Flow Database:| 2011-11-14 154633 <==> Now |
Applications Users URLs Initistors Responders Threats ¥olP L] Devices

Crante Fute || Filter View | Tarervale [l Fiows | Group: | Apphcation - @!_ : x 0@ E
Applcation SessHons Total Packsts Takal Bytes =

(] (373 %8 1,065, 534 BI4, 390,609

@) Kk 2,479 555,063 553,996,364

] General SEP contral 4,544 14,524 11,854,574

] Genersl LEP 8,310 18,788 5,501,065

i Vem 15 3655 2,747,531

O S 2,759 12,346 2,367,622

O General DS 9,570 30,457 1E34,082

O 5 308 3,232 1,081,092

O General HTTP 13,650 15,214 743,212

O General HTTRS 5,603 6413 309,616,

O Genersl TOP 5,120 6,071 301,360

Contents

T status Fo—

=

Topics:
e Common Columns on page 80
e VoIP Columns on page 81
e Detail Tooltips on page 81

e Flow Tables on page 82

Common Columns

These columns are common to all tabs.

e Check Box: Allows the selection of the line item for creation of filters and rules.

@ | NOTE: General-type applications and unknown users cannot be included in a rule.

e Main Column: The title of the Main Column depends on the selected tab. For example, if the Users Tab is

the selected, then the Main Column header will read “Users”. In that column, the name of the Users
connected to the network are shown. Clicking on an item in this column will bring up a tooltip with
relevant information on the item; see Detail Tooltips on page 81.

e Sessions: Displays the number of sessions associated with the item in the Main Column. Clicking on this

number will display a Flow Table of all the sessions.

e Total Packets: Displays the number of data packets transferred per item.

e Total Bytes: Displays the number of bytes transferred per item.

e Ave Rate (KBps): Displays the rate at which data is transferred per item.

e Threats: Displays the number of threats encountered by the network per item.
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e Total: Displays, at the bottom of the list, the total Items listed, Sessions, Total Packets, and Total Bytes
sent during the duration of the current interval.

VolP Columns

These columns are unique to the VolP tab:
e Out of Sequence/Lost Pkts: Displays the number of packets either out of sequence or lost per item.
e Avg litter (msec): Displays the average jitter rate, in milliseconds, per item.

e Max Jitter (msec): Displays the maximum jitter rate, in milliseconds, per item.

Detail Tooltips

Each item listed in the Main Column provides a link to a Detail tooltip, which appears when an item link is
clicked. The information provided by the tooltip depends on the tab. For example, clicking on an Application
column item in the Applications tab displays a Signature Details tooltip, while clicking on a User column item in
the Users tab displays a User Details tooltip.
Topics:

e Signature Details on page 81

e User Details on page 81

e Initiator Details on page 82

e Responder Details on page 82

e Device Details on page 82

Signature Details

Signature Details

Metworking General HTTPS MGMT — signature identified via well known protocol type field or well known port number in the
1P header or UDPTCP headers of the packet respectively.

User Details

User Details

admin -
IP Address: 10,0,203.115

Domain:

Auth Type: Internal User

IP Address: 10.0.204.53

Domain:

Auth Type: Internal User

IP Address: 10.0.204.141

Domain:

Auth Type: Internal User

1P Address: 10.0.204. 164

Namaine i

SonicWall SonicOS 6.2 Administration Guide
Monitoring Real-Time Network Data



Initiator Details

Initiator Details

Mo Data Available

Responder Details

Responder Details

No Data Available

Device Details

Device Details

10.203.28.1

MAC Address: 00:19:07:0C:7C:00
IP Address: 10,203.28.1
Interface: %1

Device Hame: 00:19:07:0C:7C:00

Flow Tables

Each item in the Sessions column contains a link to a Flow Table containing relevant information on that
session/flow: Start Time, Last Update, Init (Initiator) MAC, Resp (Responder) MAG, Init IP, Resp IP, Proto, Init
Port, Resp Port, Init Iface, Resp Iface, Init Bytes, Resp Bytes, Rate (Kbps), Status, and Details.

The Flow Table appears when a link is clicked. Further information can be obtained by hovering the cursor over
the Statistics icon in the Details column. Doing so displays a tooltip containing Flow ID, Init Gateway, Resp
Gateway, VPN Traffic, App Name, and, if relevant, Intrusion Name, Virus Name, and/or Spyware Name.

Flow Table
Start Last Init Resp Init Resp Init Resp  Init Resp Init Resp  Rate g
Time Update MAC MAC P P Port Port Iface  Iface  Bytes  Bytes  (Kbps)

. . o
ﬁ'w'ﬂ Aug ﬁ.m.‘m AU 0019:07:0C7COD 00:00:00:00:00:00 10.0203.115 102032835 6 61474 443 *1 *1 3467 2516 - Closed @
18:11:03 A 18:11:06 A
= - a “? 00:1S:0T0CTCOD | 00:00:00:00:00:00 10.0.203.115  10.203.28.35 6 61519 443 X1 X1 467 B1E - Closad @
18:11:38 Aug  18:11:39 A
- = - Y% 00:19:07:0C:7C:00  00:00:00:00:00:00 10.0.203.115 10.203.28.35 & 61559 443 X1 X1 Flow ID: 23602128

Init Gateway: 10,203.28.1
18:11:13 A 18:11:15 A
= - = “? D0:SI0TOCTCOD 00:00:00:00:00:00 10.0.203.115  10.203.28.35 6 61540 443 X1 X1 Resp Gateway: 0.0.0.0

VPN Traffic: Mo
184100 Aug 1BAL0E Aug | 4 10,07.007C,00 CO:0D00:0D:00:00 10.0203.115 102033835 6 61513 443 Xt X1 App Mame: e Gy
13 3 Intrusion Name: -

Virus Name: =
18:10:45 Auvg  18:10:48 Aug |
= = 00:1%:07:0C:7C:00 | 00:00:00:00:00:00 10.0.203.115  10.203.28.35 & 61484 443 X1 X1 Spyware Name: -
18:11:38 A 18:11:39 A
= = - “9 DD:1S:0T0CCIO0 | 00:00:00:00:00:00 10.0.203.115  10.203.28.35 6 61598 443 X1 X1 3467 2556 10484 Active @
ﬁ’n’B A ﬁ:n:z‘r A9 001S070CTCOD O0:00:00:00:00:00 10.0.203.115 102032835 & 61582 443 X1 X1 17 /6 - Clos=d (
18:10:31 Avg 18033 Awa o . .o oooooooi ool oo . S e . = n fa 2
4 I |
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Pie Chart View

The Pie Chart View displays the number of top items and the percentage of bandwidth used by each. The
percentage of bandwidth used is determined by taking the total amount of bandwidth used by the top items
and then dividing that total by the number of items.

General NETBIOS, 0.124%

Service Firewall 550 Agent 1, 0.267%
General DHCP, 0.521%

Ganeral ICMP, 1.169%
Sarvice Echo, 2.401%
General DNS, 4.821%

General HTTPS MGMT, 90.598%/

Flow Chart View

25.0Kbps
Name: Service Echo
Rate: 0.000 Kbps

20.0Kbps

15.0Kbps

10.0Kbps

L.0Kbps

m 2l ONS I
0
12:32 1233 12:34 12:3% 12:36 12.37 12:38 12:35 12:40 141
rh Eost Frequent | AutoY-Scaling

The Flow Chart View displays the network usage according to the Kbps used over the specified period. For each
AppFlow Monitor tab, you can select, in the:

e Drop-down menu below the chart, what the chart displays:

e Most Frequent—The top entries in the AppFlow Monitor tab.
@ NOTE: The most frequent entries may change over time. If you select Most
Frequent, you can restrict the most frequent entries to those displayed at a
particular time by clicking the lock icon next to the drop-down menu.
e One or more of the individual entries in the AppFlow Monitor tab.
e Scaling field:
e Auto Y-Scaling (default).

e A specific number and optional unit for scaling.
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Filter Options

® | NOTE: Filter options are available only in List view although they affect the other views.

The AppFlow Monitor Filter options allows you to filter incoming, real-time data. You can apply, create, and
delete custom filters to customize the information displayed. The filter options apply across all the AppFlow
Monitor tabs.

+| Filter View = | Load Filter: — Selectinput Fiter - [\ﬁ‘] b4
[ Fiter: | Data Source:
Applications Users URLs Initiators Responders Threats VoIP VPN Devices Contents
Fllter View | Intzrval: L3St2 MiNUES o Groum  Madis Typs - IPVesom [PY421P o IE ¢ » B DB () Status

AppFlow Monitor filter options

Option Widget Description
Add to Filter + Adds the current selection to filter.
At least 1 item must be selected to use the filter options.

After doing so, all other tabs will update with information
pertaining to the items in the filter.

Removes all the current selections from the filter view by
clicking on the X.

Remove from Filter Flver View 7]

Filter Element - Indicates a filter element.
»> Applications v [x| h
— | Networking General HTTPS =
MGMT --
Networking General DNS -- %
Service Service Firewall =
550 Agent 1 --
Load Filter Load Filter: ~ Selectinput Fiter - + Loads existing filter settings or creates a new filter.
Save IHl Saves the current filter settings.
Delete Deletes the current filter settings.
4
Filter View Button s Correlates data among the tabs.

Creating Filters

Creating filters reduces the amount of data seen in the AppFlow Monitor. You can create simple or complex
filters, depending on the criteria you specify. By doing so, you can focus on points of interest without distraction
from other applications.

Topics:
e Creating a Filter with Filter View on page 85
e Viewing Entries in Filter View on page 85
e Saving Filter Views on page 85
e Deleting Filter Views on page 86

e Creating a Filter with the Filter Text Field on page 86
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Creating a Filter with Filter View

Creating a filter with Filter View correlates data among selected tabs.

To create a filter using Filter View:

1

2
3
4

Navigate to Dashboard > AppFlow Monitor.

Select a tab; for example, Applications or Users.

Select the checkbox(es) of the item(s) on the tab you wish to add to the filter.
Click either the Filter View button or the Add to Filter button.

After entries have been added to the filter, only those entries are visible in the tab. In the other AppFlow
Monitor tabs, only information about those items associated with the filtered entries are visible.

Tabs with a filter are indicated by a button in the Filter View.

|_+| Filter View *  Applications v x|

To further refine the filter, select another tab and repeat Step 3 and Step 4. Each tab is added to the Filter
View.

|+| Filter View E_Ir Appﬁmﬁmsvijl_-‘-' Users v (% Rﬁpnndersvéﬂ.- ‘,HHX!

Viewing Entries in Filter View

For a quick look at the items in a filter view, click on the name of the tab in the filter view. A drop-down menu
appears listing all items selected in that tab.

| + | Filter View I_EJ Applications » [x| 2 Users ¥ E[ Responders w [x|

Filter:

10.203.28.35 =
10.201.0.52 =
10.200.0.52 [x]

To close the drop-down menu, click the name of the tab in the Filter View.

Saving Filter Views

You can save a filter view for future use.

To save a filter view:

1

Click the Load Filter drop-down menu.

Load Filter: — Select/Input Filter | »

i - Select/lnput Fiter - |
Select the blank line at the top of the list.
Enter a friendly, easy-to-remember name for the filter.

Click the Save Filter button next to the Load Filter drop-down menu.

Load Filter: Large Bandwidth Usc « @
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Deleting Filter Views

You can delete all the filter views, the filter view of a tab, or just a few of the items in a particular filter view.

How to delete filter views

To Delete Do This
All the filter views Click the X in the Remove from Filter button
A particular filter view Click the X in the Filter View button for that tab

One or more items in a filter view  Click the name of the tab to display the drop-down menu, and then click
the X next to the item(s) to delete

A saved filter Select the filter in the Load Filter drop-down menu and then click the
Delete button to the right of the Load Filter drop-down menu

Creating a Filter with the Filter Text Field

The Dashboard > AppFlow Monitor page has a Filter text field in which you can enter a text string to use for
filtering the displayed information. Valid text strings are names such as Google, Firefox, or IP addresses.

=

Generating Application Visualization Report

The Application Intelligence and Control feature allows you to maintain granular control of applications and
users by creating bandwidth management policies based on local pre-defined categories, individual
applications, or even users and groups. With the Application Visualization feature, you are able to view real-
time charts of applications, ingress and egress bandwidth, Websites visited, and all user activity. You are able to
adjust network policies based on these critical observations. The Application Usage and Risk Report combines
the results of these two features in a downloadable report listing the following categories:

e High Risk Applications in Use

e Top URL Categories in Use

e Applications with the Highest Bandwidth Usage
e Application Usage by Category and Technology
e Top Findings of Network Characteristics

e Recommendations based on the Top Findings

To generate an Application Usage and Risk Report:
1 Navigate to the Dashboard > AppFlow Monitor page.
2 Click the Print PDF Report icon from the AppFlow toolbar. The Reports pop-up menu displays.
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3 Click the Generate Report button to get a dynamically generated report specific to your firewall.

® | NOTE: The report may take a few minutes to generate and download.

Reports

Generate Application Visualization Report

Click Generate Report to receive a detailed application report based on your
network traffic,

Download & Visualization database for offine report generation.

| (enerate Report Cancel

After the report is generated, an executive summary is provided at the top of the report for a holistic overview
of your network. The report contains a real-time snapshot of network traffic to guide you in implementing new
bandwidth management policies. An example Application Usage and Risk Analysis report is provided below
listing applications with the highest bandwidth usage, their application category, number of sessions,
application risk level, and a detailed description of the application.

Application Usage and Risk Analysis Report example

Applications with the Highest Bandwidth Usage

The following applications are wsing the most bandwidth on the network . Reviewing this list will help you
evaluate how much of vour bandwidth is being used for appropriate business pumposes and howmuch
bandwidth iz being used for nonbusiness purposes.

Applications Category Sessions Etes Rizk
Symantee Live Update APP-UPDATE 2304093242 ELEWATED
TR PROTOCOLE 16320360021 [uaroED]
| Geogle natics BROWSING-PRIACY 15223253304 [isevere ]

Mote: There are multiple non-business orierted spplications in the top 20 applications including photoe-wideo, gaming,
and anline poker.

Symantec Live Update

Symantec Live U pdate is an application that downloads and installs security updates and sotvware patches. &
valid subschption is required to obtain the latest virus definitions; older versions of Symarntec Live Update may
not detect the latest virus definitions until the application iz updated.

FTP

File Transfer Protocol (FTR) is & standard network protocol used to copy afile from one host to another
over the Internet, FTP Users may authenticate thernselves using a clear-test sign-in protocol, but can
also connect anonymously if the serveris configured to allow . Typically, no verification is performed
on the supplied data.

Google Analytics

Google Analytics analyzes the user's data using analysis tools, data exporting applications, and third
party solutions.
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IPv6 App Flow Monitor

For complete information on the SonicOS implementation of IPv6, see IPv6 on page 2171.

App Flow Monitor Visualization is configured the same in IPv6 and IPv4. Select the View IP Version from the
drop-down menu to change the view/configuration.

TP Verston: | [Pwd & P o

IPvd
IPvE
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Configuring AppFlow Statistics and
Viewing Reports

e Dashboard > AppFlow Reports on page 89

AppFlow Reports on page 90

Common Functions on page 95

Viewing AppFlow Data on page 98

Downloading AppFlow Reports on page 101

Dashboard > AppFlow Reports

Dashboard | AppFlow Reports

Filter String:

| Applications |

Users

i Viruses

View:  Since Restart

1 General HTTP

12 Service SMB

15 General RADIUS

Totak 15item(s)

~ Limit:

1 General HTTPS MGMT

2 General DNS

3 General HTTPS

4 General TCP

5 General SMTP

3 General NETBIOS

7 Service NTP

8 General UDP

9 Service RPC Services (IANA)

10 General HTTP MGMT

13 Service DCE EndPoint

14 General Orade data

up time: 32 Days 03:47:47

125.69K

45.01K

27.46K

15.66K

2.85K

864

795

412

142

37

222.95K

21

12%

L

Al ] ] ] sl ] ] ] ] |
SRR R o 2

%

it

[y

]
B

Y

A
i
£

Intrusions

290.80M

15.96M

3.61M

815.22K

149.1XK

67.39K

30164

313K

11.58M

27.48K

894

288

288

2,236

147

323.36M

Spyware

43

[

A s ne A A A Lo e A o ne A - B
a o GlOE (R R A B[R] R

Location

+  SINCE: 08/14/2014 11:33:25.000 UPTIME: 32Days 03:46:25 |3/ (=2 E ) (@)

s3469M  [[E#%] 0 0 0
14,534 31,968 ] 0
17.87M 26,087 0 0
720.22€ 0 0 0
139.40K 1 ] 0
0 864 0 0
290.93K 0 0 0
0 412 i 0
45468K 0 0 0
375.7K o 0 0
752 21% 6 0 0
0 3 0 0
0 & [ 0
0 5 0 0
0 <1% 1 0 0

629.08M

() Aggregate AppFlow reporting is enabled. & Apps Reporting is enabled. To configure, go to AppFlow > Flow Reporting,

Intrusions

last update: 15:20:35 Sep 15

The AppFlow Reports page provides configurable scheduled reports by applications, users, IP addresses, viruses,
intrusions, spyware, locations, botnets, and URL rating. AppFlow Reports statistics enable you to view a top-
level aggregate report of what is going on in your network and, at a quick glance, answer such questions as the

following:

e What are the top-most used applications running in my network?
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e Which applications in terms of total number of sessions and bytes consume my network bandwidth?
e Which applications have viruses, intrusions, and spyware?
e What website categories are my users visiting?

The report data can be viewed from the point of the last system restart, since the system reset, or by defining a
schedule range. Reports also can be sent by FTP or by email.

TIP: The Dashboard > AppFlow Dash page displays the top ten items in each category (except IP
addresses) in graph format. See Dashboard > AppFlow Dash on page 71.

To configure your AppFlow Reports, follow the procedures described in AppFlow > Flow Reporting on page 1784.
The bottom of the Dashboard > AppFlow Reports page has a link to the AppFlow > Flow Reporting page.

The bottom of the page displays the:

e Totals for each column, such as number of entries, number of bytes sent by the initiator and responder,
locations blocked

e Total up time of the appliance in days, hours, minutes, and seconds

e Time of the last update/reset: hour, minute, second, month, day

Topics:
e AppFlow Reports on page 90
e Common Functions on page 95
e Viewing AppFlow Data on page 98
e Downloading AppFlow Reports on page 101

AppFlow Reports

The Dashboard > AppFlow Reports page displays these reports on separate tabs:
e Applications on page 91
e Userson page 91
e |Pon page 92
e \iruses on page 92
e |Intrusions on page 93
e Spyware on page 93
e |ocation on page 94
e Botnets on page 94

e URL Rating on page 95
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Applications

| Applications ||

View: On Schedule

Sessions

Init Bytes

Resp Bytes

Bothet
Block

Location Viruses Intrusions Spyware

S Block

Block

1 General HTTPS MGMT 225 [Thaw | sem  [Dmek ] 7ov  [Deow ] o i 0 0 0 0 0
[ e—— 22%  [Mgase ] ue3x [ o Tz ] 2037 0 0 0 0 0 0
| i Service 350 Agent 1 ok [[ige ] 8ssk [gs ] o0 Leim]o 0 0 0 0 0 0
4 GeneralDNS e [Caze ] 5223k [ome ] 14w s ], 0 0 0 0 0 0
|5 GeneralsuTe 203 [3n ] 05Kk [cam] o0 [ <1% ] a0z 0 0 0 0 0 0

&  General HTTPS 75 [ ] sz [qme ] 3104k [3m ] 0 0 0 0 ] 0
‘ 7 ServiceNTP 33 [cim] 25 [am]sax [<mly 0 0 0 0 0 0
8 General NETEIOS 21 [cim] 16 [aml]o Letm] n 0 0 0 0 0 0
|9 ServiceDRP 5 [ci% ] 6971k [ 1% ] 1986 [ <am] g 0 0 0 0 0 0

e Name—Name of the application — the signature ID

e Sessions—Number of connections/flows both as a number and as a percentage

e |nit Bytes—Number of bytes sent by the initiator both as a number and as a percentage

e Resp Bytes—Number of bytes sent by the responder both as a number and as a percentage
e Access Rules Block—Number of connections/flows blocked by firewall rules

e App Rules Block—Number of connections/flows blocked by the DPI engine

e Location Block—Number of connections/flows blocked by GEO enforcement

e Botnet Block—Number of connections/flows blocked by Botnet enforcement

e Viruses—Number of connections/flows with viruses

e Intrusions—Number of connections/flows identified as intrusions

e Spyware—Number of connections/flows with spyware

_!7hppi'mti:rl§ || users || TP :_;7\ﬁm§€57 T || 7Sp-n\rare7i_\ Location I!Bntne'tsi:l llRlH.ﬂI:ingr:
View: OnSchedde - Limiz 50 +| | Configwe | sTATE: N Schedule fuming) @ (%) (8) (B) (@) | () Staws

Intrusion

Spyware

User Name

1 UNKNOWN

2 admin

2 item(s)

e User Name

e Sessions—Number of sessions/connections initiated/responded both as a number and as a percentage
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e Bytes Rcvd—Number of bytes received by the user both as a number and as a percentage
e Bytes Sent—Number of bytes sent by the user both as a number and as a percentage

e Blocked—Number of sessions/connections blocked

e Virus—Number of sessions/connections detected with a virus

e Spyware—Number of sessions/connections detected with spyware

e Intrusion—Number of sessions/connections detected as intrusions

IP

7| Applications Users 1 hig Viruses F || Intrusions -47 Spyware ! Location || Bolnets ! URL Rating |
View:  Since Restat  » Limin 50 ~  SINCE: 08/14/2014 11:33:25.000 UPTIME: 32 Days 06:52:02 ! m [ EI c
IP Address Se Bytes Revd Bytes Sent Blocked Virus 5 £ Intrusion
1 10.203.28.40 167.03K 328.79M B4% |  618.26M 847 0 0 0 I+
z 10.0.203.115 139.29K 555.7iM 57 | 244.26M 30472 0 0 0 E
3 10,203.28.75 82.03 16.69M 806.29K 64491 0 0 0
4 10.200.0.52 38.73K 2.19M 1% 23.85M 21712 0 0 o
5 10.50,193.54 14,93k 35.53M 47.09M 21 0 0 0
6 10.201,0.52 111K 0 <1% 4.91M 11114 i 0 0
7 10.0.203.131 176K <1% 5.61M 1.86M 0 i 0 i
8 10.0.204,138 1.56K 1.34M 1.65M 0 0 0 0
9 204.212.170.13 146K 76.46K <1% 75.87K <1% 0 (] ] a
10 10.128.1.120 12K 2,89M 1.28M 0 0 0 0
11 10.199.199.1 866 0 <1% 67.55K <1% 866 i 0 0 &
Totak 50 item(s) 462.34K 962.82M 962.82M 130.59K 0 [} 0

e IP Address
e Sessions—Number of sessions/connections initiated/responded both as a number and as a percentage
e Bytes Rcvd—Number of bytes received by this IP address both as a number and as a percentage

e Bytes Sent—Number of bytes sent by this IP address both as a number and as a percentage

Blocked—Number of sessions/connections blocked
e Virus—Number of sessions/connections detected with a virus
e Spyware—Number of sessions/connections detected with spyware

e Intrusion—Number of sessions/connections detected as intrusion

Viruses
| Applications || Users || :___.\Eruscs || Intrusions || Spyware || Location || Botnets || URLRating
View:  Since Restat | Limit: 50 ~| SINCE:08/14/2014 11:33:25.000 UPTIME: 32Days 07:04:26 (3% (=) (B (@

Virus Name

Mo Entries

e Virus Name

e Sessions—Number of sessions/connections with this virus
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Intrusions

Intrusion Name

View:  Since Restart ~ Limit: 50

-

Intrusions | Spyware ||

SINCE: 09/11/2014 10:35:57.000 UPTIME: 4 Days 08:20:30

Sessions

e |Intrusion Name

e Sessions—Number of sessions/connections detected as an intrusion

Spyware

| Applications || Users |

i

P || Viruses || Intrusions u Spyware

Spyware Name

View:  Since Restart ~ Limit: 50

-

SINCE: 09112014 10:35:57.000 UPTIME: 4 Days 08:21:31 '! ! I-'-‘"d

Location || Botmets || URL Rating
NEUE

|
@
|/ e

e Spyware Name—Name of the spyware signature

e Sessions—Number of sessions/connections with this spyware
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Location

_' Applications ' Users | P ' Viruses Il Intrusions Spyware I_:71.1)1:131:'“:41 ' . Botnets || URL Rating
View: |GinceRestat | SINCE: 09/11/2014 10:35:57.000 UPTIME: 4Days 08:3%:46 (38 (1) (E) (@) () Status
Country Name
1 Anonymous Proxy 0 Caam] o Ceam] 0 Caml o
2 Satellite Provider o Ceame] o [em] o ] o
3 Fl andors 0 C<im] o [cam] o Lam] o
4 E= united Arab Emirates 0 C<1m] o0 [<rm] o [<m] o
5 Bl Achanistn 0 Ceam] o Ce] 0 Caml o
5 E Antigua and Barbuda o C<pm] o0 (=T ez ] 0
7 = = I 0 Ceam] o0 Cm] 0 Tzl o
8 [ - 0 Caam] 0 Ce] 0 Tzl o
3 B amenis 0 Caam] o Cex] 0 Tzl o
10 E Netherlands Antilles 0 @ 0 @ o [E] a
1 B e 0 Caam] o Cerz] 0 Cxiz] o
12 @ Asia/Pacific Region o [E] 0 m o [E 0
13 EX  antarctics a C=im] o Ceze] 0 ] o
14 B Agentina 0 Cxam] o Caam] 0 Cawl o
15 American Samoa o Cxm] o o] 0 ] o
15 B austia 0 [an] o [cam] o Lam] o -
Totak 253 item(s) (1] ] ] 1]
e Country Name—Name and flag of the country initiating/responding to a session/connection
e Sessions—Number of sessions/connections initiated/responded by this country both as a number and as
a percentage
e Bytes Revd—Number of data bytes received by this country both as a number and as a percentage
e Bytes Sent—Number of data bytes sent by this country both as a number and as a percentage
e Dropped—Number of sessions/connections dropped
View | Sice Restat - SINCE: 03/11/2014 10:35:57.000 UPTIME: 4Days 08:41:03 (3% () ()
= Botnet Name Sessions
i Botnet Detected a
2 Botnet Blocked 1}
Totak 2 item(s) 0

e Botnet Name:

Botnet Detected

Botnet Blocked
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Sessions—Number of sessions/connections where a botnet was detected/blocked

URL Rating

[ Appiations | Bsers |[ | Viuses | [ Znbvusions | [ Spywars
View: Since Restat v  SINCE: 03/11/2014 10:35:57.000 UPTIME: 4 Days 08:57:31
Rating Name

i Violence Hate Radsm 0 m =
2 Intimate Apparel/Swimsuit a Ccim]

3 Mudism 0 Cerze ]

4 Pornography 0 @

5 Weapons 0 [E]

6 Adult/Mature Content 0 Tz ]

7 CultfOccult 0 <1z ]

8 Drugs/Tlegal Drugs 0 Cero ]

3 Tlegal Skills/Questionable Ski 0 @

10 Sex Education o E

11 Gambling 0 <t ]

12 AlcoholfTobacco 0 Cerze ]

i3 Chat/fInstant Messaging (IM) 0 [ﬂ]

14 Arts/Entertainment 0 Ccam]

15 Business and Economy 0 @

-

Totak 56 item(s) 0

Rating Name—Name of the URL category

Sessions—Number of sessions/connections both as a number and as a percentage

Common Functions

The following functions are common to all the tabs:

Specifying the Data Source on page 96

Downloading SonicWall Security Services Signatures on page 96
Limiting the Display on page 96

Creating a CSV File on page 98

Printing the Display on page 98

Refreshing the Display on page 98
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Specifying the Data Source

You can select the source of the report data in the Data Source drop-down menu:

Data source: IEZIEY

Local

AppFlow Server
GMSFlow Server

e Local (default)

e AppFlow Server, if available

e GMSFlow Server, if available

Downloading SonicWall Security Services Signatures

The AppFlow Reports feature requires that you have the latest SonicWall Security Services signature downloads
enabled for the latest dynamic protection updates.

Click on the Status button on any tab to view the list of enabled SonicWall Security Services as illustrated below.

+ | SINCE: 08/14/2014 11:33:25.000 UPTIME: 32 Days 04:15:15 (3§ (@) (B (&

Licensed Status Signatures To Configure...

App Control Advanced: Yes Enabled Downloaded Firewall = App Control Advanced
Gateway Anti-Virus:  Yes Enabled Downloaded Security Services > Gateway Anti-Virus
Intrusion Prevention: Yes Dizzbled Downloaded Security Services = Intrusion Prevention

Anti-Spyware: Yes Dizabled Downloaded Security Services = Anti-Spyware
Content Filtering: Yes MfA /A Security Services = Content-Filter
Country Database: MfA M/A Downloaded MN/A

Geo IP Blocking: Yes Disabled MfA Security Services > Geo-IP
Botnet Blocking: Yes Enabled M/A Security Services > Botnet Filter

:::‘:2' Aggregate AppFlow reporting is enabled. -,‘f/J Apps Reporting is enabled.

Note: To configure, go to AppFlow = Flow Reporting.

— = e —=

The pop-up displays the following for each service generating an AppFlow Report:
e Whether the service is licensed, not licensed, or a license is N/A (not applicable)
e Whether the service is enabled, disabled, or N/A
e Whether the relevant database has been downloaded for the service or NA

e Alink to the relevant SonicWall page for configuring the service

Limiting the Display
You can limit the amount of data displayed in these ways:

e Limiting the Number of Entries Displayed on page 97
e Filtering the Data on page 97
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Limiting the Number of Entries Displayed

You can limit the number of entries displayed in a report by selecting one of these numbers from the Limit drop-
down menu:

Applications | Users iy Viruses

View: Since Last Feset v Limin: 50 -

10
25

MName 50
100

150
General HTTPS MGMT Unlimited

e 10
e 25
e 50 (default)

e 100
e 150
e Unlimited

NOTE: The number of entries for the Location, Botnets, and URL Rating reports cannot be limited.

®

Filtering the Data

You can limit the display to only certain entries in a tab by specifying a string in the Filter String field. The string
is not case sensitive.

Filter String: -

The filter applies only to the active tab and does not affect the display of the other tabs. Displaying another tab
erases the filter for all tabs.

The filter can be as general or specific as necessary. For example, entering 10.2 for the IP tab returns 4 entries
while entering 10.203 returns only 2:

Applications || Users || IP || Viruses || Intn‘ | Applications || Users || IP || Viruses | Intru
View: Since Last Reset » Limin 50 - [] view: Since Last Resst » Limin 50 - |_
IP Address IP Address
1 10,203.28.75 8.86k 1 10.203.28.75 8.89K
2 10.203.25.40 3.5% 2 10.203.28.40 3.5
3 10.200.0.52 1.03k
4 10,201.0.32 212
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Filtering by tab

For This Tab Filter by
Applications Name

Users User Name

IP IP Address
Viruses Virus Name
Intrusions Intrusion Name
Spyware Spyware Name
Location Country Name
Botnets N/A

URL Rating Rating Name

Creating a CSV File

You can create a CVS file of a tab’s data by clicking the Export icon. For example, if you click on the Export icon
for the Applications tab, this file is created:

sonicflowAggr-applications-2.csv o B OR
' B c p | E | F | @ H ] ] K L M N | o | P
| 1 |Index Name Flows Rate Init Bytes Resp Byte ACL Block DP1Block GEO IP Blc Botnet Blc Virus Intrusion Spyware FlowsPct Init Bytes Resp[ |
| 2 1 General HTTPS MGMT 132941 0 3.04E+08 6.13E+08 0 o o 0 o o 0 51 89
| 3 | 2 General DNS 55892 0 18834419 15084905 38239 o o 0 o o 0 21 3
| 4| 3 General HTTPS 43664 0 4520987 18486942 42240 o ] 0 o ] 0 16 1
| 5 | 4 General TCP 15248 0 1001592 885086 0 o o 0 o o 0 7 o
| 6 | 5 General SMTP 3504 0 183020 171344 1 o o 0 o o 0 1 o
| 7| 6 General NETBIOS 950 0 74100 ] 950 o ] 0 o ] 0 o ]
| 8 | 7 Service NTP 822 0 311904 301188 0 o o 0 o o 0 o o
| 9| 8 General UDP 412 0 31312 o 412 o o 0 o o 0 o o
| 10| 9 Service RPC Services | 146 0 11957448 466422 0 o ] 0 o ] 0 o 3
11 10 General HTTP MGMT 37 i} 27430 375723 i} o o i} o o i} o o

-

=[!

@ NOTE: This is not the same CSV file as that created by downloading an AppFlow Report (see Downloading
AppFlow Reports on page 101).

Printing the Display

If your appliance has a printer, you can print the data on a tab by clicking the Print icon.

Refreshing the Display

You can refresh the display by clicking the Refresh icon.

Viewing AppFlow Data

You can view the AppFlow data in these ways:

e Since Restart on page 99

e Since Last Reset on page 99

e On Schedule on page 99
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Since Restart

Applications Users || IP Viruses Intrusions Spyware || Location Botnets || URL Rating

View: Since Restat  » Limit: 50 - SINCE: 09/11/2014 10:35:57.000 UPTIME: 4Days 02:16:01 (2§ (=) (B (&) (&) Status )

To view AppFlow data since the last reboot or restart of the firewall, select Since Restart from the View drop-
down menu. This report shows the aggregate statistics since the last reboot of the device. The date and time of
the reboot are given in green as well as the total up time, in days, hours, minutes, and seconds, since the reboot.
For example, SINCE: 08/14/2014 15:40:06.000 UPTIME: 32 Days 01:25:10.

@ TIP: The up time is also displayed at the bottom of the page along with the date and time of the last
update.

Since Last Reset

_' Appfu:ahms 1 Users | P il Viruses || Intrusions | Spyware ! Location Botnets | URL Rating |

S — ) (B (B @ | )
View: Snce Last Reset » Limit: 50 + | Resst | siNcE:03/15/201413:00:55.000 UPTIME: 0Days00:02:00 (38 () (B (@) () Status.

To view AppFlow data since the last reset of the firewall, select Since Last Reset from the View drop-down
menu. This report shows the aggregate statistics since the last time you cleared the statistics by pressing the
Reset button. The date and time of the reset are given in green as well as the total up time, in days, hours,
minutes, and seconds, since the reset. For example, SINCE: 08/14/2014 15:40:06.000 UPTIME: 32 Days 01:25:10.

The reset option allows you to quickly view AppFlow Report statistics from a fresh reset of network flows. The
reset clears the counters seen at the bottom of the page, which displays counter totals for number of sessions,
initiator and responder bytes, to the number of intrusions and threats.

On Schedule

To view AppFlow data by a defined schedule start and end time, select On Schedule from the View drop-down
menu and click the Configure button. This report shows AppFlow statistics collected during the time range
specified in the configure settings options. Once the end time of the schedule is reached, scheduled AppFlow
statistics are exported automatically to an FTP server or an email server. AppFlow statistical data is exported in
CSV file format. Once the AppFlow statistics are exported, the data is refreshed and cleared.

To configure an On Schedule AppFlow report, perform the following configuration of selecting either an FTP
server or email server for CSV file export:

1 Navigate to the AppFlow > AppFlow Reports page.

2 Select On Schedule from the View drop-down menu.

| Applications || Users || IP || Viruses || Intrusions || Spyware || Location || Botnets || URLRating |

View:  On Scheduls » Limit: 50 - l Corfigure: | STATE: TN Schedule (unning) @ (38 “-UE] '-3-‘ (/) Status |

App Location BotMet

Blodk Blodk

Sessions Init Bytes Resp Bytes Rules
Block

1 General TCP LIK &% ] 220k [35% ] o0 T 1,773 0 i 0
2 Service 530 Agent 1 807 Mo | 6779 [ 205 ] 0 Caxlo 0 o 0
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3 Click the Configure button. The Schedule Report pop-up dialog displays.

Set Schedule
Actions
Send Report by FTP
FTP Saryen ||]-ﬂ‘-ﬂ-ﬂ

User nams! |admin
Password: |P555W°'d
Directory: |'EP°"'5

Send Report by E-mail
E-mail Sarven ||]-ﬂ‘-ﬂ-ﬂ

E-mail Ta: |

From E-mail: |
SMTP Por: 25

D POP Before SMTR
Pop Server:  [0.0.0.0

User name: |

Password: |
Mas User Entries: 200
Max IP Entries: 200

4 Have your AppFlow Reports data automatically sent to either or both an:
e FTP server by selecting the Send Report by FTP checkbox.
e Email server by selecting the Send Report by E-mail checkbox.
5 For reports sent by FTP, enter these options:
e The FTP server address in the FTP Server field.
e Auser name in the User name field; the default is admin.
e The password in the Password field.
e The directory in which to send the reports in the Directory field; the default is reports.
6 For reports sent by email, enter these options:
e The address of the email server in the E-Mail Server field.
e The recipient’s email address in the E-mail To field.
e The email address used for the sender in the From E-mail field.
e The SMTP port number in the SMTP Port field.

7 If your email server requires SMTP authentication, select the POP Before SMTP checkbox.and enter
these options

e Address of the POP server in the Pop Server field.
e User name in the User name field
e Password in the Password field.
8 Enter the maximum number of user entries in the Max User Entries field; the default is 200.

9 Enter the maximum number of IP entries in the Max IP Entries field; the default is 200.
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10 Click the Set Schedule button to define a start and end schedule. The Edit Schedule dialog displays.

Schedule Name: [AppFlow Report Hours
Schedule type: ) Once @ Recurring () Mixed
Once

Year Month Day Hour Minute
Star L~ | -] [+] [ -] L]
End: L~ | -] [ +] [~ L]
Recurring
Day(sh Sun Man Tue Vied

Thrs Fi St Al
SwanTime: | |:| | (24 Hour Formar)
SwpTme: | |:| | (24 Hour Formar)
Add

Schedule List! | SU-M-T-W-TH-F-3 00:00 to 24:00 -

Delete Delete All

11 In Schedule type, select:

e Once to create a one-time schedule. The Once schedule options allow you to set reporting
schedules based on a calendar start and end date with time in hours and minutes.

e Recurring to create an ongoing scheduled. The Recurring schedule options allow to select
ongoing schedules based on days of the week and start and end hour and minute time targets.

e Mixed to create both a one-time schedule and an ongoing schedule.
The Recurring and Mixed schedules display your selections in the Schedule List.
12 If you selected Recurring or Mixed for the schedule type, complete the schedule times:

e For both Recurring and Mixed, in the Recurring section, specify the day(s), Start Time and Stop
Time of the schedule.

e For Mixed, in the Once section, specify the Year, Month, Day, Hour, and Minute for the Start and
End of the report.

13 Click OK to save your AppFlow Reports schedule.

14 On the Schedule Reports options page, click the Apply button to start using your AppFlow Reports
schedule object settings.

Downloading AppFlow Reports

You can download the AppFlow Reports to one of these formats:

e (CSV (Microsoft Excel Comma Separated Values File)—opens in Excel as a swarm.csv file

@ NOTE: This is not the same csv file that is generated by clicking the Create CSV File icon (see
Creating a CSV File on page 98).

e DOC (Microsoft Word Document)—opens in Word as a swarm.docx file

e PDF—opens as an html file in the browser window
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To download a report:

1 Navigate to the Dashboard > AppFlow Reports page.

Dashbozrd | AppFlow Reports

Filter String: Data So|

Applications i Users P Viruses || Intrusions || Spyware || Location || Botnets || URL Rating

View: Since Restat = Limit: 50 +  SINCE: 09/11/2014 10:35:57.000 UPTIME: 5Days07:2422 (3% (2 (B (&)

Sessions Init Bytes Resp Bytes Rules :LE;ES é l';';"_\_ﬁon : i::;jEt
Block Block
1 General TCP 16.8K [[Hasp | 87428k [ 29 ] 0 L] 6813 0 0 0 0
2 General HTTPS MGMT 144 [oas | 262m  [EEer | 1942w [Tags | ¢ 0 0 i i
3 Service 550 Agent 1 764  [[is% | 64235 [q% ] 0 L] o 0 0 0 0

2 Click on the Send Report icon. The Download Application Visualization Report pop-up window displays.

Reports

Download Application Visualization Report

Click Download Report to receive the Visuslization database for offline report
generation of your network traffic.

_ Download Repott | | Cancel

3 Click the Download Report button. An Opening file.wri.sfr window displays.

You have chosen to open:

|| aggr04-COEAE42CB1B2-2014091618082 1. wrisfr
which is: sfr File
from: https://10.203.28.76

What should Firefox do with this file?
() Open with Browse...

@ Save File

Do this autemnatically for files like this from now on.

4 Click OK to save the file. The file is downloaded to your Downloads folder.
5 Open a browser window.

6 Log on to mysonicwall.com.
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7 Navigate to SW Tools > App Reports. The Upload Report page displays.

Welcome, Techpubs Techpubs |

Logout

My Products
My Account
My Groups

My Orders

v w w|lwllw

FlexSpend

Reports

-

Downloads

-

Support

Service Requests
Forum

My Training

My Promotions

¥ SW Tools

Migration Tool
App Reports

Postit

Upload Report

Data sets can be downloaded from a SonicWALL Network Security Challenge evaluation device in the App Flow Monitor found under the
Dashboard menu.

Microsoft Word, PDF, and OpenOffice versions of the SWARM report will be made available by the upload process. We suggest that you modify

and tailor the report for your individual opportunities. Adding personal analysis to the information provided about a particular customer's
environment will go a long way in leveraging the efficacy of the report. Additionally, you may wish to add conclusions and recommendations

Select Report File: No file selected. | Up|03d

Download Demo File

8 Click the Browse button. A File Upload window displays.

9 Locate the file and click Open. The file name appears on the Upload Report page.

Select Report File: | Browse_ | aggr04-COEAE42CB1B2-20140916180821.wrisfr | Upload

10 Click the Upload button. It may take several minutes to upload the report.

11 When the upload is complete, you can select any or all of these forms (the file has the name swarm):

Select Report File: aggr04-COEAE42CB1B2-20140916180821 wri.sf [ Upload

o CSV
e DOC
e PDF
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Viewing Threat Reports

e Dashboard > Threat Reports on page 104
e SonicWall Threat Reports Overview on page 104

e SonicWall Threat Reports Configuration Tasks on page 105

Dashboard > Threat Reports

This section describes how to use the SonicWall Threat Reports feature on a SonicWall appliance.

Topics:
e SonicWall Threat Reports Overview on page 104

e SonicWall Threat Reports Configuration Tasks on page 105

SonicWall Threat Reports Overview

Topics:
e What Are Threat Reports? on page 104
e Benefits on page 105
e How Does the Threat Reports Work? on page 105

What Are Threat Reports?

The SonicWall Threat Reports provides reports of the latest threat protection data from a single SonicWall
appliance and aggregated threat protection data from SonicWall appliances deployed globally. The SonicWall
Threat Reports displays automatically upon successful authentication to a SonicWall appliance, and can be
viewed at any time by navigating to the Dashboard > Threat Reports page:

e Viruses Blocked

e Intrusions Prevented

e Spyware Blocked

e Multimedia (IM/P2P) Detected/Blocked

Each report includes a graph of threats blocked over time and a table of the top blocked threats. Reports, which
are updated hourly, can be customized to display data for the last 12 hours, 14 days, 21 days, or 6 months. For
easier viewing, SonicWall Threat Reports reports can be transformed into a PDF file format with the click of a
button.
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Benefits

The Threat Reports provides the latest threat protection information to keep you informed about potential
threats being blocked by SonicWall appliances. If you subscribe to SonicWall’s security services, including
Gateway Anti-Virus, Gateway Anti-Spyware, Intrusion Prevention Service (IPS), and Content Filtering Service,
you are automatically protected from the threats reported by the SonicWall Threat Reports. SonicWall’s security
services include ongoing new signature updates to protect against the latest virus and spyware attacks.

How Does the Threat Reports Work?

The SonicWall Threat Reports provides global and appliance-level threat protection statistics. At the appliance
level, threat protection data from your SonicWall appliance is displayed. At the global level, the SonicWall Threat
Reports is updated hourly from the SonicWall backend server with aggregated threat protection data from
globally-deployed SonicWall appliances. Data provided by the SonicWall backend server is cached locally for
reliable delivery.

To be protected from the threats reported in the SonicWall Threat Reports, it is recommended that you
purchase SonicWall security services. For more information about SonicWall security services, see SonicWall
Security Services on page 1671.

@ NOTE: The SonicWall appliance must have Internet connectivity (including connection to a DNS server) to
receive the latest threat protection statistics from the SonicWall backend server, which reports aggregated
data from globally deployed SonicWall appliances. If you lose connectivity, cached data from the last
update will display, and the latest data will not be available until connectivity is restored.

SonicWall Threat Reports Configuration Tasks

The SonicWall Threat Reports can be configured to display global or appliance-level statistics, to display statistics
for different time periods, and to generate a custom PDF file.

The SonicWall Threat Reports displays automatically upon successful login to a SonicWall appliance. You can
access the SonicWall Threat Reports at any time by navigating to Dashboard > Threat Reports in the left-hand
menu. The introductory Dashboard > Threat Reports page, shown below, displays while the latest data is
retrieved before the System > Security Dashboard page displays.

Dashbozrd /- Threat Reports

The DELL SonicWALL Gateway Anti-Virus, Anti-Spyware and IPS subscription provides dynamic defense
against the latest threats. The innovative Threat Reports delivers real-time threat protection data from
DELL SonicWWALL security appliances deployed around the world.

Please wait while the latest data is being retrieved.

Note:If the wait time exczeds 2 minutes, pleass check the WAN connection and network ssttings.

@ NOTE: The System > Security Dashboard page contains the Threat Reports. To display this page, you need
to navigate to the Dashboard > Threat Reports page.
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System/
Security Dashboard
view: @ Global © COEAE45382D6 ‘T Download POF
Viruses Blocked Last14 Days ~
Over Time: Last 14 Days Top Viruses Blocked
Virus Name Percentage of Viruses
Hits Medpinch, AZmp3 3% I ——
1250 Badur.FDSP 21% —
Lom Happy_3 5% —
i Tepfer.J 3% -
- BrowseFox.G_7 2% =
2o AddLyrics.AE_2 2% -]
0 Perelett. 15399 2% -]
4098582 8FAA848 Kuluoz.5M_3 2% ]
tdeddddddddddag | Kuuoz.D_36 F—
Symmi.L 1% ¥
Intrusions Prevented Last14 Days ~
Over Time: Last 14 Days Top Intrusions Prevented
Intrusion Name Percentage of Intrusions
Hits ZeroAccess P2P Activity 1 64%
125M yimf-pc Brute Farce Attack 27%  —
100M SIP friendly-scanner User-Agen... 4% -]
75M UltravNC Client Buffer Overflo... 1% i
50M Server Application Shellcode E... 1% i
25M SIPVicious Activity 1 1% ]

. SIPVicious Activity 2 0.4% ]
9934885328387 48 Suspicious SMTP emall Attachme. .. 0.4% §
sddsddsddsssss Zeus COC Traffc 2 oa%

Ramnit C&C Traffic 0.3% §
Spyware Blocked Last14Days ~
Over Time: Last 14 Days Top Spyware Blocked
Spyware Name Percentage of Spyware
Hits Search_Mirade Download x.cab 0%
700K Whenl-FanzoneToolbar YWSN_FANZ... 18%  —
:::E WhenllPopup Installer 1 —
400K BrowseFox.G_7 4% —
300K Bundled-Software 2FindMP3 Setu... 2% =
200K Bundled-Software 150 Backgroun. .. % W
100K Bundled-Software AFreeConverte... 2% =
Y Timzcecsazanggg Bundled-Software AFresRipper 5. . »% =
é é é é é é é é é é é é é é MM-DD Bundled-Software AdvancedDVDPI... 1% ®
Bundled-Software AdvancedDVDPI... 1% E
Multimedia (IM/P2P) Detected/Blocked Last14 Days ~
Over Time: Last 14 Days Top Multimedia Detected /Blocked
Multimedia (IM/P2P) Name Percentage of Multimedia (IM/P2P)
Hits Shodkwave Flash (SWF) - Downl... .|
256 BitTorrent Protocol —UDP Act... .
208 ‘YfouTube — HTTP Host youtube.c... 000 —
158 Skype —DNS Skype 1 4% —
108 ‘fouTube - HTTP Referer www.yo... 4% —
- Skype -- Skype Metwork Discove. .. 3% —

0 Instagram — DNS Query instaar. .. 3%  —
4323532353388 HRFA Apple Tunes - 55L Trafficit... 3% —
EEEENEEEE-EEER MM-DD Flzsh Video (FLV) -- Download ... 3% —

Pandora Radio - HTTP Activity... 3%
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Topics:
e Switching to Global or Appliance-Level View